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Introduction 
 

smartFEM is used for simulation electrical machines using alphanumeric respectively graphical 

representation and for documentation of the calculated characteristics. For this purpose of FEM 

simulations and analyses, smartFEM uses an FE program called FEMAG, developed by Prof. Dr.-Ing. 

Konrad Reichert. Numerical techniques are used to solve static electromagnetic field problems by FEM 

and analytical methods. 

 

The following machine models (motors and generators) can be simulated by using smartFEM: 

 

- Permanent magnet brushless DC motors (internal/external rotor) (BLDC) 

- Permanent magnet brush DC motors (internal rotor) 

- Permanent magnet linear motors 

- Synchronous reluctance motors 

- Switched reluctance motors 

- Universal motors 

- Magnetization of permanent magnet internal rotors 

 

 

smartFEM was developed using Microsoft® Visual Studio® .NET and it runs on desktop computers with 

following installed Microsoft® Windows operating systems: 

 

- XP Professional Edition SP 2 

- VistaTM Professional 

- Windows 7, 8, 10 (32 and 64 Bit) 

 

Delivery: 

 

1 USB-Stick as used as dongle containing the following files: 

 

- xxx.license License to be loaded in smartFEM License Control 

 

- setup.exe Application for starting the installation manually  

- smartFEM.msi Installation package (including a FEMAG version suitable for smartFEM 

version) 

- UserGuide_en.pdf  User guide 

- Topologies_en.pdf  Description of rotor and stator topologies 
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1 Installation 
 

1.1 .NET Framework 
Microsoft® .NET Framework 4.0 is required prior to installation of smartFEM. smartFEM issues a 

verification notice if the required installation is missing. A version can be downloaded from the 

Microsoft® Download Center and installed. 

 

1.2 smartFEM 

Insert the supplied USB stick into the computer, select the "Start" button from the Windows start menu 

and enter the USB drive letters followed by the string "\:setup.exe" in the input field. For delivery by 

email, enter the location of the decompressed file "setup.exe"  

 

 

Fig. 1: Window for "Program/File search" - start setup.exe 

After pressing the “Return” button, the installation program starts and the user will be prompted for all 

the necessary input data. 

 

 

Fig. 2: Installation of smartFEM 
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Following directories and files are created during the installation process: 

 

 

Fig. 3: Program files directory 

The directories contain: 

... \ smartFEM  the smartFEM.exe program, related DLLs and user guides 

(*.pdf) 

... \ smartFEM \ Batch  templates for performing batch calculations. 

... \ smartFEM \ ElTopology  topologies of power electronics for dynamics simulation. 

... \ smartFEM \ Material Explorer  program and configuration file for describing and maintaining 

material data "Material Explorer". 

... \ smartFEM \ Materials  material files 

... \ smartFEM \ Femag  the program wfemag.exe 1) 

... \ smartFEM \ Topology  dll’s for rotor and stator topologies 

 
1)  Note:  For installation under Windows 7, the directory C:\Program Files\...\smartFEM\Femag must 

be parameterized with wfemag.exe for writing accesses, as wfemag.exe creates temporary 

files. If necessary, this directory has to be copied to a user-specific area. smartFEM can 

also be installed on any other drive and/or folder which can be accessed by user. 

 

The user-specific smartFEM configuration file “user.config” is stored in the current user directory. 

 

 

Fig. 4: User-specific files directory 



 
  
 

  

 15 

smartFEM 

Each time when smartFEM is started, a log file named “smartFEMLogFile.txt” is created and saved in 

the directory “C:\Users\User\AppData\Local\Temp\”. In it is information stored if problems occur.  

 

 

Fig. 5: smartFEM log file 

 

To repair or delete smartFEM, run setup.exe and 

make the appropriate selection. 

 

Only those files are be deleted which were 

created during the installation of smartFEM 

 

 

 

 

 

 

 

 

 

 

Fig. 6: Repair or delete smartFEM 

Permissions for Windows 10 and 11 
If smartFEM is installed in „C:\Programs(x86)\...“, then has a user with the name „Everyone“ with the 

permissions „Full control“ be assigned to smartFEM. Otherwise might Windows prohibit the correct 

use of smartFEM: 
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2 Start and Settings 
 

2.1 Start 

 

smartFEM is accessed via the Windows "Start" menu buttons 

"All Programs" → "smartFEM" → "smartFEM". 

 

 

Fig. 7: Start of smartFEM 

A start screen appears. The buttons "Help" → "About ..." display various information about the 

installed smartFEM version. 

 

 

Fig. 8: smartFEM start screen - Information about the installed smartFEM release 
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2.2 Registration and license information 

 

After the installation, smartFEM is available to the user unrestricted for 30 days. Subsequently no further 

data storage functions can be performed. 

 

Customers who have purchased a time-limited or unlimited software user license may alternatively use 

these as follows: 

 

a) Attaching the license to a USB stick. This allows smartFEM being installed on several 

computers and it can be used after inserting the USB stick on the respective computer. 

elmoCAD supplies an USB stick as standard with saved smartFEM software and license 

files. 

b) Attaching the license to the MAC address of the computer, hard disk or network domain 

as per agreement: 

• Create a license file through "License Control" → "Write License Data" 

• Send the generated license file by e-mail to info@elmocad.de  

• Read the activated license file activated by elmoCAD and returned by e-mail through 

“Help” → “About” → “License Control” → “Load” 

 

 

Fig. 9: Loading of the license file  
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2.3 Settings 

 

2.3.1 smartFEM 
 

Settings for program and data directories, etc. are displayed via the buttons "Tools" → "... Settings" and 

can be adjusted. 

 

2.3.1.1 Folders: Settings of directories 

- Geometry Topology Folder DLL files for rotor and stator topologies 

- Material Files Folder files for material data 

-  FEMAG Exe for smartFEM The FEMAG version, installed together with smartFEM, 

by which all smartFEM simulations can be calculated. 

-  User FEMAG Exe File a FEMAG version used for additional user-defined 

calculations. This version can be different from the one 

used by smartFEM. 

-  Default Working Directory Current working directory, where design data and 

calculation results are stored. 

-  Electronic Topology Folder DLL files for electronic circuit topologies 

 

 

Fig. 10: Tools - smartFEM Settings - Setting the directories  
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2.3.1.2 Saving: Settings for saving models 

 

 

Fig. 11: Tools - smartFEM Settings - Storage of the model data 

All model data incl. calculation results are saved in a XMLformated file with name *.mot  

 

-  "Automatic Adding Extension to File End" 

"_" and an ascending number are attached to the file name for each 

storage process i.e. filename_1.mot 

-  "Dynamic Calculation - Save Only Last Period" 

Only the result data corresponding the last BEMF period is stored in 

dynamic calculations. 

-  "Auto Saving After" 

Automatically saves the model data after each selected calculation 

process: 

- Pre-processing 

- Cogging and BEMF Calculation 

- Nominal Torque and Inductance Calculation 

- Dynamic Calculation 
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2.3.1.3 General: General Settings 

 

 

Fig. 12: Tools - smartFEM Settings - General settings 

Topology Window: 

-  "Geo Accuracy" 

All geometry points of drawing objects i.e. lines, arcs, etc., which are lying in 

a circle with defined diameter, are treated as the same point.  

 

Motor Parameter Window: 

-  Enables entering a user-defined "Min. Rotation Step " in window “Motor 

Parameters”. 

 

FEMAG Process Detection: 

-  Enters the monitoring period for a running FEMAG process. If during this time 

no CPU time is consumed by FEMAG, it is assumed that the calculations 

performed by FEMAG are either completed and result files are saved or a 

FEMAG error has occurred and no results are available. In this case, the 

cause of the error must be clariyfied and the calculation restarted.  

 

Generate Complete Motor Model 

-  With this is it possible to display in smartFEM main graphic window the 

complete motor model and rotate it. 

 

Show FEMAG Calculation Window 

- With this is it possible to display or hide the FEMAG 

windows during all FEM calculations. The FEMAG 

windows can also be switched on and off for single 

FEM calculations by right mouse click on the 

related button. 

 

- In FEMAG release 9.7.34.10 windows are generally hidden. 
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2.3.1.4 GUI: setting for the graphical user interface 

 

 

Fig. 13: Tools - smartFEM Settings - GUI settings 

Topology Window: 

Selection of the action for the "Return” key:  

- “Apply Changes and Exit“ 

Apply all changes and exit the topology 

-  “Apply Single Parameter Only“ 

Apply the parameter value of the actually selected parameter field whereby 

the cursor remains in this parameter field.  

 

Flux Lines Colors: 

- Definition of the colors of Flux lines used in “Plots”. Default color is black. 

 

Winding Coils Icon: 

- User defined color and size of icons and text in the graphic window of 

“Windings”. 

 

Drawing Parameters: 

- User defined thickness of “Open Geometry”, “Intersecting Geometry” and 

“Dimension” lines and arcs. 
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2.3.2 Project 
 

Via "Project Settings", project information such as project number, project name, etc. can be added to 

a perspective motor design. They are displayed among other things in the project report generated by 

smartFEM. 

 

Fig. 14: Tools - Project Settings 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.3.3 Material Legend 
 

Through "Material Legend Settings" the colors and 

designations can be set for surfaces used in the current 

motor design for each project separately. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 15: Tools - Material Legend Settings 
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3 Developing with smartFEM 
 

1.1 Motor Geometry 

 

After starting smartFEM and 

selecting the menu "File → New", 

you can select a motor type. Only 

those types of motors are displayed 

for which rotor and stator topologies 

are stored in the topology list. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 16: Creating a new motor type 

 

After pressing the "Apply" button, a new motor model is created based on the preset parameters for 

rotor and stator geometry, and the motor geometry is displayed for a BEMF period in a graph. 

 

 

Fig. 17: Motor Geometry 
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Depending on the selection in the lower area of the geometry window, further geometry views are 

displayed together with according information contents, like for example: 

 

Fig. 18: FEM model with minimal geometrical 

symmetry of rotor and stator 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 19: FEM model zoomed 

In all the views, after clicking the left 

mouse button to a certain position, 

the scroll wheel can be used to zoom 

in any content as far as possible.   

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 20: Measurement of distances 

After selecting the button "Measure 

Distance Between Points", distance 

measurements between two mouse-

clicked positions can be performed. 
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3.1.1 Developing steps  
 

Developing the simulation model up to the first simulation or calculation is best done through the 

following steps: 

 

• Defining rotor geometry 

• Defining stator geometry 

In case of external or internal rotor motors, the internal or external diameter of the stator is 

automatically adjusted to the external or internal diameter of the rotor. 

• Selecting materials 

• Input of winding scheme and winding parameters.  

• On the base of the selected coil/slot combination of rotor and stator, 

a winding scheme with maximum BEMF is automatically suggested. 

• Defining motor and calculation parameters 
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3.1.2 Rotor 
 

After selecting the "Rotor" button, the geometry of the rotor topology is drawn in the graphics window 

and the corresponding parameters are displayed in a pop-up window in three groups "Geometry", 

"Basic" and "Elements". 

 

By opening the selection field "Types of Rotor", all rotor topologies saved in the smartFEM topology 

folder for the corresponding motor type are displayed.  

 

 

Fig. 21: Selecting a rotor topology 

After selection of a topology the geometry parameters are displayed immediately in the graphical window 

and its associated alphanumerical parameter in the before mentioned three groups (tabs): 

- “Geometry” these parameter define the geometry based on Cartesian or Polar 

Coordinates of points which are connected by arcs, lines and/or 

curves. 

- “Basic” these parameter describe general values assigned to the geometry 

- “Elements” these parameter display properties of arcs, lines, curves, areas and 

points. Different parameter can be edited, i.e. to parametrize node 

chains. 

 

The geometry can be displayed in the graphical window as:  

- drawing of arcs, lines and curves 

- colored areas showing the material 

- node chains 
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3.1.2.1  „Geometry“ Parameter 

 

The parameters describing geometry are displayed in the parameter group "Geometry". As soon as the 

cursor is positioned into a parameter field using the mouse or "Tab"-key, parameter specific dimension 

arrows are displayed as help information in the graphic. 

 

  

Fig. 22: Rotor - Geometry parameter 

Each input of a new value (e.g., Width of Magnet) results in re-calculation of the geometry, which is 

redrawn directly in the graphic window. Parameter fields with green font contain calculated parameters, 

which are used for information and cannot be changed. 

 

 

Fig. 23: Rotor - Display of modified geometry 

Parameters, which have been changed after selecting the topology, are only accepted and saved after 

pressing the "Apply" button. If you leave the parameter window via the "Exit" button, no changes are 

accepted and the origin geometry is displayed again. 
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The “Un-Do” and “Re-Do” buttons allow user to refuse 

actual input i.e. in case of faulty input and display the 

previous value. 

 

   

 

 

 

Fig. 24: Rotor - Un-Do and Re-Do 

 

 
3.1.2.2 „EditGeometry“ – User Defined Geometries 

 

Beginning with smartFEM release 2.11 is possible to edit user defined geometries .  

 

 

Fig. 25: Edit Geometry - User defined Elements 

Details are described in the document „Topologies 2.11.00 de.pdf“ which can also be opened by 

menu „Help – About“. 

 

3.1.2.3 Plausibility Checks 

 

In order to develop geometry, the user can enter parameter values in any order. Due to their dependence 

on other values, they initially might not appear plausible because they are outside of the currently 

permissible value range. The Geometry is therefore only consistent when all parameters are entered 

with correct values. 

 

Immediately after the input of one value, all values are subjected to a consistency check. Depending on 

the type, the identified incompatibilities are treated as follows: 

 

• If a value is entered which is too small or too large, it can be automatically reset to the 

permissible minimum or maximum value. I.e. the magnet cannot be wider than the 

sector of the rotor. The input value of the number of magnets has a higher priority. 

• The lines and surfaces affected by the entered value with the resulting overlaps are 

displayed in the graphic in red color, the "Apply" button is renamed to "Bad Geometry" 
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and is also changed into red color. The user has now to correct the last input value or 

change other values so that the geometry no longer has any inconsistencies. 

 

Fig. 26: Rotor - Plausibility checks 

• Open lines and arcs are displayed in blue color. It is not a problem if these are positioned 

on the sector lines to the air gap. These lines are in dependence of the rotor type 

necessary to connect the rotor geometry to the air gap layer. If further open lines or 

circular arcs exist after a DXF import of a rotor or stator geometry, this must be checked 

and corrected in the CAD drawing (see also DFX import). The line thickness can be set 

in "smartFEM Settings - GUI". 
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3.1.2.4 „Basic“ Parameter 

 

In the parameter group "Basic", the so-called basic parameters can be edited: 

 

 

Fig. 27: Basic parameter 

 

• Basic node angle  Minimum node distance at the air gap in deg. A precise 

definition and explanation is given in 3.1.2.5 

• Decimal Places  The number of decimal places displayed. 

  All parameters are rounded according to the input or before 

output. 

• Scaling Factor  A scale for enlargement or reduction exclusively for rotor 

geometry. All input parameters are multiplied by this factor. 

  Exception: Internal or external radius of the stator in the 

case of internal or external rotors. They are calculated from 

the outside or/and inside radius of the rotor + air gap. In this 

case, the stator parameters are stretched in the radial 

direction. 

• Node chain connection to air gap  This is used to control the connection of the geometry to the 

air gap. 

• Priority  This is used to control whether the input value "Node 

Distance Factor" or "Number of Segments" on the node 

chains is kept constant when geometry parameter are 

changed. 
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3.1.2.5 Node Chains 

 

The base for the required mesh for the FEM calculations are the node chains represented from the 

drawing elements: "line", "circular arc" and "curve section". The node chains are built from every drawing 

element by segmented lines whereby nodes indicate begin and end of each segment.  

 

 

Fig. 28: Node chains with indication of the base node angle 

The number of the segments is calculated by: 

 

- Rotating motors: 

Number of Segments = Integer ( ������� �����	

�� × 
��� �������� ������) 

Bna  = Base node angle [°mech] respectively [deg]  

 = angle between 2 nodes at the air gap arc with center point P(x,y) = (0,0) 

element length in rad] 

Node distance factor = element-specific factor (editable in parameter group "Elements") 

 

- Linear motors: 

Number of Segments = Integer ( ������� �����	

�� × 
��� �������� ������) 

Bnd  = Base node distance [mm] 

 = distance between 2 nodes at the airgap line 

Node distance factor = element-specific factor (editable in parameter group "Elements") 

 

Base node angle and element-dependent factors are pre-set for each topology with values that provide 

a “good” network for the FEM calculations 

 

The user can adjust the base node angle respectively base node distance in the parameter group 

"Basic". It applies to all drawing elements. The element related factors are adjusted individually in the 

group "Elements" for each drawing element. 
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The setting of the node spacing in the central air gap layer, which 

is important for an accurate power calculation, can be carried out 

in the dialogue field "Motor Parameters" with the parameter "Min. 

Rotation Step" (see also 3.6). It should be chosen in such a way, 

that the network elements get the shape of a square as much as 

possible. 
 

 

Fig. 29: Node chains in the air gap 

3.1.2.6 Adjustment of node chains 

 

By clicking the right mouse button on 

a drawing element (point, line, arc), 

the element is highlighted with 

additional information.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 30: Rotor geometry - Representation of node chains 

 

Simultaneously, the parameter 

window changes to the group 

"Elements", the cursor is positioned 

in the relevant parameter field and 

additional information is displayed.  

 

An element can also be selected by 

entering the element number.  

 

The distance between nodes can be 

entered in the parameter field "Node 

distance factor" as a multiple of the 

base node distance for the selected 

element. Subsequently, the number 

of segments is calculated. When 

entering the "Number of Segments" 

the "Node distance factor" will be re-

calculated according to this number.  

Fig. 31: Rotor geometry - "Elements" group 

If the length of the element is changed, the "Node distance factor" or "Number of segments" is kept 

constant, depending on the setting of the parameter "Priority" in the "Basic" parameter group.  
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When creating lines, non-linear node spacing can be generated with the help  of  an  additional  factor 

-1 ≤ „Nonlinear node distance factor“ ≤ 1 in order to adjust distances between nodes at the beginning 

and end of a line to the adjacent elements. By changing the sign, the direction of the node spacing is 

reversed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 32: Rotor geometry - Non-linear node chains 

 

3.1.3 Stator 
 

The stator geometry is, just as the rotor geometry, selected and processed accordingly. Here are also 

several stator typologies available, which the user can select. 

 

When selecting "One Coil Per Slot" or "Two Coils Per Slot", either "one-layered" or "two-layered 

fractional slot winding" will be set as a winding type. In some stator typologies, for "two-layered fractional 

slot windings", it is possible to select lower/upper layer with equal surface areas, in addition to the 

position in the left/right slot half.  

 

The editing of node chains is analogous to the rotor. 

 

 

Fig. 33: Stator - Edit 

 

3.1.4 Saving, DXF and FEMAG export 
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After editing the rotor and stator geometry, the entire model can be saved and the geometry will be 

exported in FEMAG- and DXF file formats. 

 

 

Fig. 34: Saving and exporting a motor geometry 

All drawing elements of a topology can be exported into a DXF-File based on the format specification of 

“AutoCAD® dxf-reference”: 

 

- Rotor 

- Stator 

- Periodic Model 

- FEM Model 

 

Additionally can be selected whether only “Material” or “Steel Material” contours should be exported. 

 

In the menu of all topologies can DXF files be created with all the text information regarding the 

properties of drawing elements, i.e. Basic Parameters and Element Information. 

 

Fig. 35: Saving and exporting a motor geometry 

Further details are described in chapter "7.3 DFX Export”.  

 

 

 

3.2 Materials  
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By clicking the left mouse button on the "Material" button, a pop-up window is opened for the entering 

of material data for electrical sheets, magnets and coils. 

 

 

Fig. 36: Material Settings - Assignment of material properties 

The “Relative Length” of material refers to the length of the motor, which can be edited in “Motor 

Parameters”. It is used together with the material densities for the calculation of masses and moments 

of inertia and are also taken into account for calculation of BEMF, torque, etc.  

 

 

3.2.1 Stator Coil 
 

 

Fig. 37: Material Settings - Stator coil parameter 

The parameter values of “Conductivity”; “Mass Density” and “Relative Length” can be edited. Default 

values are provided for copper material. “Mass” and “Area” of this material of the complete machine are 

calculated values based on the mass density and related coil of area the stator including head windings.  
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3.2.2 Stator and Rotor Steel 
 

 

Fig. 38: Material Settings - Stator steel parameter 

User can select material type “Linear” or “Non-Linear” and in case of  

- “Linear”  

values for “μr”, “Mass Density” and “Relative Length” can be edited. 

-  “Non-Linear” 

A material file containing properties i.e. BH curves, loss data, mass density, etc. can be selected 

from a drop-down list. Only the “Relative Length” can be edited. 

 

 

Fig. 39: Material Settings - "Non-Linear" steel parameter 
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For assignment of different materials in stator and rotor topologies for individual areas can 

different material numbers "MatNo" be assigned in parameter group “Elements” which then are 

displayed in toned down colors. This has to be done first before the material data can be 

assinged accordingly to "MatNo" in “Material Settungs” for stator and rotor steel. 

 

 

Fig. 40: Material Settings - Assignment of different material numbers “MatNo” for different areas within one topology 

 

Creation and maintenance of the material files with BH-Curves and loss data/coefficients can be done 

with the “Material Explorer” software (see 3.2.5 Material Explorer / Material Editor). 

  



 
  
 

  

 38 

smartFEM 

3.2.3 Magnets 
 

For description of the magnet properties in case of “Linear” calculation remanence induction “Br”, relative 

permeability “μr”, “Conductivity” and “Magnetization” of the magnetic material have to be specified.  

 

 

Fig. 41: Material Settings - Magnets 

In case of “Non-Linear” calculation can the demagnetization characteristic curves and loss coefficients 

also be defined with the “Material Explorer” and selected in „Material“.  

 

The magnetization direction can be set on "Parallel", "Radial", "Halbach" and "User Defined" whereby 

the direction of magnetization is displayed in the graphical window.  

 

 

Fig. 42: Material Settings - Magnetisation 
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For “Parallel” magnetization an offset angle for rotation of the magnetization direction can additionally 

be specified.  

 

In case of “Radial” the 

magnetization can be additionally  

edited in a text table, displayed in 

a graphical window and saved as 

text file *.dat in the material folder. 

The magnetization is 

automatically adjusted to the 

respectively selected magnetic 

width (Wm = 180 °el). 

 

  

Fig. 43: Material Settings - Magnetization table 

 

In "User Defined" 

magnetization, for 

each individual 

magnet, all parameter 

shown in the text table 

can be edited and set 

as "Default". 

 

Fig. 44: Material Settings - User defined magnetisation 

 

There is also a possibility of importing measured magnetization of ring magnets and converting it for the 

use in smartFEM and FEMAG. 

 

Fig. 45: Material Settings - Measured magnetization 
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Additional parameters have to be entered in the menu "Measure Options" to complete the measurement 

data.  

 

 

  Fig. 46: Material Settings - Additional parameters for measured magnetization 

 

3.2.4 Relative Length 
 

For permanent magnets and soft iron can different magnetic effective length of the materials in axial 

direction (z-axis) be taken into account whereby a constant flux is assumed. Reference value is the 

axial length of the air gap = 100%.  

 

   

 
For windings is the value of the “Relative Length” taken into account for calculation of the ohmic 

resistance. Furthermore is the “Relative Length” taken into account for the calculation of the mass of all 

materials.   
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3.2.5 Material Explorer / Material Editor 
 

The material properties of electrical steel and permanent magnets can be edited and viewed with the 

smartFEM “Material Explorer“. It includes an interface to convert the material data into formatted files 

which can be used for FEM calculations with FEMAG, JMAG, MAXWELL, SPEED and into formatted 

text files for individual use in other software tools. 

 

The Material Explorer was developed in collaboration with thyssenkrupp Steel Europe AG (TKSE) in 

Bochum, Germany. TKSE provides the software named as “PowerCore® Explorer” independently from 

smartFEM.  

 

The functionality of Material Explorer is described in the document "User Guide Material Explorer". 

 

3.2.5.1 Electrical Steel 

 

With installation of smartFEM, the data of three TKSE standard materials for non-linear calculations are 

copied into the smartFEM material folder. Further material data of TKSE product range can be received 

directly from TKSE in Bochum. 

 

 

Fig. 47: Material Explorer - B(H) and loss data of electrical steel 
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3.2.5.2 Permanent Magnets 

 

In addition to electrical steel, with the help of Material Explorer also non-linear "demagnetization 

characteristics curves" of permanent magnets can be recorded and can be stored as FEMAG specific 

mc-, mca- and txt-files. For this purpose, the material type “Permanent Magnet” must be selected when 

storing the files.  

 

 

Fig. 48: Material Explorer - Demagnetization characteristics of magnet material 

At present, the demagnetization characteristics curves of a material for different temperatures have to 

be individually recorded and stored.  

 

Loss coefficients and loss data are currently not used by smartFEM. To calculate the eddy current 

losses in the magnets, the conductivity entered in "Materials" is used.  

 

The creations of the characteristics for non-magnetized magnetic material are analogous to the 

characteristics for electrical steel. This data is used in the simulation of magnetization processes with 

the smartFEM module „PM - Magnetization - Inner Rotor“.  
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3.3 Preprocessing 

 

A prerequisite for the calculation of results and their analysis by FEM simulation is the structure of the 

FEM model in FEMAG. After pressing the "Preprocessing" button, FEMAG is started, all necessary 

information about geometry, node chains and materials is transferred to FEMAG, and the FEMAG 

process from smartFEM to the field calculation is controlled by the FEMAG menu sequence "Field 

Calculation" → "Calculate Once". 

 

 

Fig. 49: Preprocessing - Structure of the FEM model with FEMAG 

After successful "Preprocessing", the button "Calculation" will be displayed. The user can now carry 

out a first FEM simulation with determination of the cogging torque (if applicable at this time) (see 

3.6.1 Cogging Torque and BEMF). 

 

The "Preprocessing" can be controlled with right-click on the "Preprocessing" button as follows: 

 

- Show / Hide FEMAG  Show / Hide FEMAG windows. 

- Stop FEMAG on Error  FEMAG is paused after an error, so that the user can determine 

the cause of the error. 

- Only Meshing  Only meshing is performed. 

- Preprocessing + Calculation  After "Preprocessing", the calculation type selected in Motor 

Parameters is automatically executed. 

 

 

Fig. 50: Preprocessing - Show FEMAG 
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After "Meshing" has been successfully completed, the network representation can be opened via the 

"Plots" button.  

 

 

Fig. 51: Preprocessing - Meshing and node chains 

"Preprocessing" can be completed after optimizing the mesh by further pressing the "Preprocessing" 

button.  

As soon as a change to motor geometry or material is made any later time then the text "Calculation" is 

automatically reset to "Preprocessing", all results are deleted and the preprocessing must be run again. 

 

For the calculation of further results e.g. BEMF, Torque, etc., the motor model has to be completed 

together with information on windings and further motor parameters (see 3.4 Plots and 3.6 Motor 

Parameters). 

 

The calculation of the field distribution in the inner region of the rotor (region < inner rotor radius Rri) 

can be performed on complete machine models (360°mech). It can be selected in “Motor Parameters 

– Options – Calculate and Mesh Shaft”. 

 

 

Fig. 52: Preprocessing - Calculate and Mesh Shaft Area 
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Fig. 53: Preprocessing - Calculate and Mesh Shaft Area (2) 

This type of meshing is only possible for complete machine geometries (CompleteGeometry=true) 

because in all other cases boundary conditions are required by Femag. 

 

Remark: the field distribution is be calculated without this inner mesh wrong for 2-pole machines! 

 

 incorrect field distribution proper field distribution 

    

Fig. 54: Preprocessing - incorrect field distribution  
Fig. 55: Preprocessing - proper field distribution 
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3.4 Field Plots 

 

3.4.1 Definition and display of field plots 
 

After successful "Preprocessing", the design of the magnetic circuit can be assessed using "Plots". To 

do this, in the "Field Plots Definition" menu, "Plots - Define Picture" must be opened: 

 

 

Fig. 56: Field Plots - Field Plots Definition 

After opening the plot window (it is possible that FEMAG field calculations are performed beforehand), 

the various plots can be selected and displayed: 

 

 

 

 

 

 

Fig. 57: Field Plots - Magnetic induction with 

superimposed flux lines 

 

Fig. 58: Field Plots - Demagnetization 

Flux lines, scaling and other parameters can be adjusted by clicking the right mouse button on the 

selection field. 

The plots can be viewed on the screen as well as on the project report. All plots can be overlaid. The 

overlay is undone by a further click on the corresponding button. The number of flux lines as well as the 

minimum or maximum values of the result calculations can be adjusted by clicking the corresponding 

button with the right mouse button.  
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Furthermore, details can be viewed at any depth using the already mentioned zoom function. In 

addition, the x/y coordinates of the mouse pointer and other information are displayed in the status 

line. 

 

The user can select from the following plots: 

• Geometry 

Points 

Lines 

Areas 

• FEM-base 

Node 

Node chains 

Networking 

Materials 

 

• Magnetic circuit results 

Vector potential 

Current densities 

Flux lines 

Magnetic flux density 

Demagnetization 

Relative permeability 

Remanence 

Magnetic polarization 

 

A bigger number of sets can be created easily by using the “Parametic” function. 

 

 

Fig. 59: Field Plots - Table for parametric definition of sets  
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3.4.2 Model Data 
 

For user-defined evaluation, the properties of nodes and network elements can be exported via the 

clipboard: 

 

 

Fig. 60: Field Plots - Export Model Data 

 

Fig. 61: Field Plots - Exported model data example 

Through "Calculate", the torque, radial force and the angle of the force vector in the air gap can be 

calculated. At the same time, the data is made available in the buffer memory. 

  

Fig. 62: Field Plots - Force in Air gap 
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3.4.3 Creation of Filed Plots with the same layout 
 

In the "Field Plots Definition" table several images can be defined for different rotor positions and 

currents. They can be defined individually with "Define" → "Picture” using different contents. Currents 

can be entered manually or transferred from the results of "Expected values", "Nominal Torque" or 

"Dynamic” for the selected table lines through the "Data" → "Paste Currents" dialogue ". 

 

 

Fig. 63: Field Plots - Definition of sets 

 

The images can also be created 

with "Solve All". In this case all the 

images show the same section. 

However, to achieve this, the 

settings of an image must be saved 

beforehand via "Options" → "Save 

Settings" as well as the image itself 

with "Define Picture". 

 

 

 

 

Fig. 64: Field Plots - Saving settings after 

crating the image content 
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If then an image with "Show Picture" is opened and the arrow keys are used to move up or down in 

the "Field Plots Definition" table, all images are displayed successively, so that the field changes can 

be observed very well. By clicking on a column header, the table is sorted up or down according to the 

column values. 

 

 

Fig. 65: Field Plots - Display of the plots per set 

 

Flux lines can be displayed in different 

colors (black/white is default). By clicking 

the right mouse button on the "Flux Lines" 

button, a corresponding pop-up window 

opens.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 66: Field Plots - Colored flux lines 
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In the smartFEM settings, the colors for the 

direction of the flux lines can be adjusted 

clockwise and counterclockwise. 

 

 

 

 

 

 

 

 

 

 

Fig. 67: Field Plots - Colored flux lines 

 

The table „Field Plots Definition“ can be copied into 

the clipboard containing all calculation results. 

 

 

 

Fig. 68: Field Plots - Copy Results 

 

 

Fig. 69: Field Plots - Table containing calculation results 
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3.5 Windings 

 

For the description of windings, there is a winding editor available at smartFEM. If there is at least one 

permissible winding scheme for the motor geometry described up to this point, the button "Winding 

Defined" is displayed and the winding scheme is set as default. Otherwise the text "Winding Not Defined" 

is displayed in the button. N-phase winding patterns can be described as single/two-layered with 

integral/fractional windings and parallel winding groups/phase. 

 

 

Fig. 70: Winding Editor - Opening the smartFEM button "Winding ..." 

The number of slots (S ..) and individual coils (C ..) together with current direction (in/out) are displayed 

in the winding surfaces.  

 

The color and the size of the text and 

icons can be set in "smartFEM 

Settings - GUI".  

 

 

 

 

 

 

 

 

Fig. 71: Winding Editor - The color and the 

size of the text/icons in smartFEM Settings 
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3.5.1 Coils Parameters 
 

Through "Winding Definition" → "Coils 

Parameters" a pop-up window will be opened 

in Which input fields the wire diameter, number 

of turns per coil and an additive phase 

resistance/induction can be entered.  

 

For a conductor type, "round" or "rectangular" 

can be selected.  

 

In addition, the slot area available for the 

winding per slot and the fill factor are 

displayed. The fill factor is calculated as 

follows:  

 

Fill Factor = Number Of Turns per coil *  

         Conductor Area / Slot Area   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 72: Winding Editor - Coils parameters 

 

With “Options” another menu is displayed. It 

provides functions for specifying the number of 

turns, calculating the number of turns at a 

predetermined filling factor and calculating the 

conductor cross section with predetermined 

values for fill factor and number of turns 

available. 

Fig. 73: Winding Editor - Coils parameters - Options 
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3.5.2 Winding Scheme 
 

Through "Winding Definition" → "Winding Scheme", the winding scheme can be processed in a list. As 

additional support, the entire motor is displayed as a graph. As soon as there is a permissible winding 

scheme, it is displayed as "Auto Winding“. The slots corresponding to the phases are colored. The slot 

area in which the cursor is located is shown in yellow. With the help of "Auto Winding" the winding 

scheme is generated, 

with the maximum 

induced voltage.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 74: Winding Editor - Winding scheme "two-layer fractional slot winding" The values for 

amplitude Flux Vector, Distribution, Pitch and Winding factor are displayed 

 

   

Fig. 75: "Two-layered fractional slot,  "One-layered winding"  "Ring winding" 

„Options": 

- "Default Winding": The winding scheme with which the window was initially opened, 

appears again. 

- "Auto Winding":  The winding scheme with maximum BEMF will be automatically       

determined and displayed. 

- "Symmetric Winding": The input for the phase U is automatically assigned into the V and W 

phases with an offset of + 120 ° el. 

- "Clear All":  The winding pattern is deleted and can then be redefined by the user. 

By clicking in an entry field from the list, are not yet specified windings 

shown and can be selected. The corresponding slot surface is then 

filled with the color of the respective phase. 

 



 
  
 

  

 55 

smartFEM 

 

Fig. 76: Winding Editor - User-definition of the winding scheme 

A user-defined winding scheme is adopted by clicking the "Apply" button. The entire winding definition 

can be saved with "File" → "Save Winding Definition" in a text file *.wdf and later used in other motor 

models through "File" → "Open Winding Definition".  

 

 

Fig. 77: Winding Editor - Saving or loading a winding definition 

The winding editor is closed with "Apply Changes", in case that the winding definition should be adopted 

for the current motor model. If the current motor design should not be changed, the winding editor has 

to be closed via "Cancel".  
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3.5.3 Phase Diagram  
 

Through the "Diagrams" menu, the vectors of the phases and coils are displayed. With this is the user 

able to check the winding scheme for faults. 

 

 

Fig. 78: Winding Editor - Phasor Diagram 
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3.6 Motor parameters and calculations 

 

Depending on simulations and calculations the user wants to carry out, various motor parameters must 

be entered.  

 

All simulations of the motor are related to rotor positions. Starting from the normal 0° position of the rotor 

is it rotated counterclockwise by a certain angle after each calculation in order to perform the next 

simulation. The number of calculation steps and the calculation accuracy can be specified as a 

termination condition by the user.  

 

The calculations are triggered via the "Calculation" button. By clicking with the right mouse button on 

the "Calculation" button, various settings can be made in accordance to the "Preprocessing" button. 

 

3.6.1 Base for the results calculations 
 

The base for the results calculation is the single-phase equivalent circuit diagram of a synchronous 

motor.  

 

The in “Results” displayed "Torque With Applied Current" represents the "inner" torque because iron, 

magnet and other losses which lead to a reduction of the torque on the shaft is not taken into account 

during FEM calculations. These losses can be calculated as a torque loss for the given speed with the 

help of the formula P = T * ω and will be considered in "Torque After Losses“.  

 

Fig. 79: Equivalent circuit diagram for synchronous motor 

In "Results" an overview of the various result parameter (i.e. losses, internal /external torque, active 

power, apparent power, power factor, cosφ, efficiency, etc.) is displayed under the tab "Overview". 

Losses are only taken into account if they have been previously calculated.  

 

 

Fig. 80: Results parameter as "Overview" table 
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3.6.2 Cogging Torque and BEMF 
 

 

Fig. 81: Motor parameter - Cogging torque + BEMF 

 

Model Parameters Info  

- Minimum Rotation Step x ° mech  

Minimum angle of rotation of the rotor step in ° mech. This also corresponds to the node angle 

in mid air gap layer between rotor and stator. Through the selection box also different values 

can be selected. The adjustment should be set so, that the net elements in the central air gap 

layer become as quadratic as possible to ensure high accuracy of the power or torque 

calculations. When "smartFEM Settings - General" is set to manual entry of "Min. Rotation 

Steps ", any user-defined step width can be specified. 

- Cogging torque Period x ° mech  

Cogging period in ° mech.  

- BEMF Period x ° mech  

Period of the induced voltage in ° mech.  

- Maximum Number Of Steps x  

Maximum number of calculation steps per period. 2 periods are calculated.   

 

Calculation parameter 

- "Movement Type" 

User can choose between the calculation for the entire period or a part of the period. When 

choosing a partial period, only cogging torque and flux are calculated. 

- "Permeability Mode" 

With the help of this tab, the calculations in FEMAG are controlled. When "Restored" is 

selected, the calculations are started at each step angle with "zero". When "Actual" is selected, 

it starts with the result of the previous step angle. This has an influence on the number of 

iterations and, if necessary, also on the accuracy of the calculation results. This needs to be 
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evaluated and selected individually by the user. "Restored" ends in very good results, but it 

sometimes requires significantly more iterations and thus calculation time. 

- "Number of Calculation Steps per period" 

The calculation of Cogging Torque + BEMF is carried out through two cogging torque periods. 

The specification of the minimum rotor rotational angle is dependent on the period length, in 

order to keep the calculation time within acceptable range that is justifiable to the accuracy of 

the curve.  

- "Convergation Accuracy" 

Termination condition for the calculation accuracy of the permeability changes in FEMAG. 

- "Motor Length" 

Motor length without projection = length of the axial airgap (see also chapter “3.2.4 Relative 

Length”). 

- "Skewing" 

Herewith the effects of optimization are calculated by skewing of the rotor or stator. Total angle 

of inclination and the number of skew steps are indicated.  

Skew Angle   0 = no inclination 

 n = inclination in °mech over the entire motor length 

Number Of Skew Steps  0 = no inclination 

 1 = continuous inclination on the specified angle 

 n = number of laminated cores 

 the first laminated core is always in the position of 0 ° mech! 

Example: 

 Skew Angle = 15 °mech 

 Number Of Steps = 4 Skew 

 Angular offset of the laminated cores to each other =  

 15 °mech / (4-1) = 5 °mech 

- “Operational speed” 

Rated speed of the motor in revolutions per minute. 

- “Winding Connection” 

Winding circuit "star" or "triangle". 

With "Reset Results" previous calculated results are deleted, with "Apply" the entered data is 

accepted and the window is closed, with "Exit" the window is closed without saving the data.  

If the preprocessing has already been performed, then the calculation can be started by 

pressing the "Calculation" button. 

 

„Apply, Exit, Reset Results“  

With “Reset Results” previous calculated results are deleted, with "Apply" the entered data will be 

accepted and the window will be closed, with "Exit", the window is closed without changing any data 

which were entered before.  

 

 

Fig. 82: "Apply, Exit" Motor Parameters 
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After “Preprocessing” has been performed before can now the calculations be started by pressing the 

button “Calculation”. The calculation results are shown in a graphic form. Both graphics and numerical 

result values can be copied to other applications via the clipboard. 

Fig. 83: Results - Results Cogging Torque 

Overview of all the results of a "Cogging Torque + BEMF Calculation" in the form of graphs: 

 

 
 

As smartFEM determines and stores the flux for each slot and rotor position, the results are determined 

without further FEM calculation if the winding scheme, motor length, skew angle, skew steps and speed 

are changed. This is displayed immediately after entering the changed parameters. 

 

 

Fig. 84: Example of influencing the BEMF by inclination 
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3.6.3 Expected Values 
 

In order to make a rapid prediction of the expected torque, the torque is determined based on the 

previously calculated BEMF using FEM and analytically calculated and displayed as "Expected Value".  

 

Fig. 85: Results - Expected Values 

The calculation is performed according to the selection of constant phase current, sinusoidal phase 

current and trapezoidal or user-specific phase current. The selection can be seen in the menu „Nominal 

Torque + Inductance Calculation“ „Coil Excitation - Current Parameters“.  Since no additional FEM 

calculation is necessary, the results are displayed immediately.  

 

Overview of all the results of a "Cogging Torque + BEMF Calculation" in the form of a graph and 

displayed as "Expected Values": 
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3.6.4 Nominal Torque + Inductance 
 

The calculation of the nominal torque is carried out in such a way that in each rotor position, the torque 

is calculated in de-energized and energized state using FEM. Subsequently, the nominal torque is 

calculated by difference formation. The adjustment of calculation parameters can be performed in "Motor 

Parameters".  

 

 

Fig. 86: Motor Parameters - Nominal Torque + Inductance 

 

3.6.4.1 Model Parameters Info  

- Minimum Rotation Step x ° mech  

Minimum angle of rotation of the rotor step in ° mech. (according to 3.6.2Cogging Torque and 

BEMF)  

- Cogging Torque Period x ° mech  

Cogging period in ° mech. 

-  BEMF Period x ° mech  

Period of the induced voltage in ° mech. 

-  Maximum Number Of Steps x  

Maximum number of calculation steps.  
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3.6.4.2 Phase Shifts 
- from Cogging Torque + BEMF Calculation  

- from Nominal Torque + Inductance Calculation  

- By execution of "Cogging Torque + BEMF Calculation" the phase angles between the individual 

windings are determined, which is then displayed in "Nominal Torque + Inductance Calculation". 

- If „Nominal „Torque + Inductance Calculation“ is 

selected, the phase angles are displayed if previously 

„Cogging Torque + BEMF Calculation“ was performed. 

- If no „Cogging Torque + BEMF Calculation“ was carried 

out, „Phase Shifts: Not Defined“ is displayed. 

If the check sign is set on "Calculate Phase Shifts“, the 

phase positions are automatically recalculated before 

the nominal torque calculation. 

For this purpose a torque calculation is performed with constant current for each phase. The 

angles (° el) of the maxima of the torques correspond to the positions of the respective phase.  

Then the actual "Nominal Torque + Inductance" calculation is carried out.  

- „Phase U/V/W: not defined“ is displayed for the motor types „Switched Reluctance“ and 

„Universal Motor“. Since these types of motors do not include magnets, it is not possible to 

calculate BEMF and the phases of the windings. These are then determined before performing 

the actual torque calculation as previously described. (See also 6.3 Switched Reluctance Motor) 

 

3.6.4.3 Calculation Parameters 

- "Movement Type" 

User can choose between the calculation for the entire period or a part of the period. 

- "Permeability Mode" 

This is used to control the calculations in FEMAG. When "Restored" is selected, the calculations 

are started at each step angle with "zero". When "Actual" is selected, it starts with the result of 

the previous step angle. This has an influence on the number of iterations and, if necessary, also 

on the accuracy of the calculation results. This needs to be evaluated and selected individually 

by the user. "Restored" ends in very good results, but it sometimes requires significantly more 

iterations and thus calculation time. 

-  "Number of Calculation Steps per period" 

The calculation of Cogging Torque + BEMF is carried out through two cogging torque periods. 

The specification of the minimum rotor rotational angle is dependent on the period length, in order 

to keep the calculation time within acceptable range that is justifiable to the accuracy of the curve.  

- "Convergation Accuracy" 

Termination condition for the calculation accuracy of the permeability changes in FEMAG. 

- "Motor Length" 

Motor length without overhangs.  

-  "Skewing" 

Herewith the effects of optimization are calculated by skewing of rotor or stator. Total angle of 

inclination and the number of skew steps are indicated.  

Skew Angle 0 =  no inclination 

 n =  inclination in ° mech over the entire motor length 

 

Number Of Skew Steps  0 =  no inclination 

 1 =  continuous inclination on the specified angle 

 n =  number of laminated cores, 



 
  
 

  

 64 

smartFEM 

  the first laminated core is always in the position of 0 ° mech! 

 

Example: 

Skew Angle = 15 °mech 

Number Of Steps = 4 Skew 

Angular offset of the laminated cores to each other = 15 °mech / (4-1) = 5 °mech 

 

Note: In the current smartFEM version, the nominal torque calculation and the loss 

calculation are only carried out for Skew Angle = 0 °! 

 

- “Operational speed” 

Rated speed of the motor in revolutions per minute. 

- “Winding Connection” 

Winding circuit "Star" or "Delta" 

 

 

3.6.4.3.1 Skewing of Rotor and Stator 

 

Skewing of rotor poles or stator teeth by a pole pitch is an appropriate possibility to reduce cogging 

torque and harmonics of the BEMF. 

 

Besides continuous skewing is it also possible to assemble the rotor with several slices in axial 

direction (discrete skewing): 

- The single slices are skewed to each other by an angle = skew angle / number of slices 

- Skewing with an infinite number of slices is then conform to continuous skewing 

 

The impact of skewing on cogging torque, etc. can easily be determined by superposition using an 

Excel sheet. 

 

In smartFEM are the results immediately displayed after entering of skew angle and number of slices 

(number of steps). For continuous skewing has number of step = 1 to be entered. 

 

Definition: 
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3.6.4.4 Stator Coil Excitation - Current Parameters 
 

Different current waveforms can be entered: 

- Constant current with amplitude indication 

 

 

 

 

 

 

 

 

Fig. 87: Stator Coil Examination - Constant Line Current 

If the "Calculate Phase Shifts" button is pressed, the positions of all phases are determined before the 

actual nominal torque calculation. 

- Sinusoidal current with amplitude indication and phase shift between current and BEMF per line 

 

 

 

 

 

 

Fig. 88: Stator Coil Examination - Sinus Shape Line Current 

- Id-Iq with indication of the currents in the d- and q-axis: 

 

 

 

 

 

 

  

Fig. 89: Stator Coil Excitation - Id-Iq Effective Phase Current 

- trapezoidal curve shape of the phase currents with amplitude indication, phase shift and 

function width. The function width is the range in which the amplitude is 100%. Flanks with a 

linear ascent and descent are shown in between: 

 

 

 

 

 

 

 

 

Fig. 

90: Stator Coil Excitation - Trapezoid Shape Phase Current 
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Fig. 91: Stator Coil Excitation - Trapezoid Shape Line Current          

 

 

 

 

 

- “Lead Phase” 

 

In case that non-symmetrical phase currents or phase positions of the BEMF result from 

geometry and/or winding scheme (which have a phase shift unequal to 360°/total number of 

phases), a single phase can be set as leading. The currents of other phases are then 

automatically defined in such a way that an equal phase shift occurs between all the currents. 

This is necessary to simulate the behavior of conventional controls that cannot produce 

unsymmetrical phase shifts. 

 

In case where no leading phase is selected, the phase shifts between the phase currents are 

defined when their result from the unsymmetrical BEMF.  

 

- user-specific curve shapes of the phase currents: 

 

 

Fig. 92: Stator Coil Excitation - User Defined Phase Current 

The corresponding settings can be made via the "Edit Shape" button. A table with a sinusoidal 

current profile is created as default. 
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Fig. 93: Stator Coil Excitation - Phase Vector Currents Input Table 

 

The user can directly modify the values contained in the table, make settings via "Options" or 

copy and paste a table of values created in another tool. 

 

 

Fig. 94: Phase Vector Currents Input Table - Current Options 

 

With "Current Options" the following settings are possible: 

"Initial Values":  Save or load the saved value table. 

"FFT Sampling":  Sampling rate for Fourier decomposition, default = 1000 

"Align with BEMF":  Adjustment of the phase positions of the current waveforms 

according to the BEMF per phase 

"Symmetric Current":  Current values input in phase U are copied to the other 

phases with a phase shift of 120 ° and 240 °. 

"Phase Shift":  A phase shift can be entered individually for all or each phase. 

"Global Amplitude Change":  The amplitudes are multiplied by the entered factor. 
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„Apply, Exit, Reset Results“  

 

With “Reset Results” previous calculated results are deleted, with "Apply" the entered data will be 

accepted and the window will be closed, with "Exit", the window is closed without changing any data 

which were entered before.  

 

 

Fig. 95: Motor Parameters - "Apply, Exit, Reset Results"   
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3.6.5 Calculation  
 

If the "Preprocessing" has already been carried out the calculations can now be started by pressing the 

button „Calculation“. After calculations are finished, can the results be presented in different graphs.  

 

 

Fig. 96: Display of results for nominal torque with sinusoidal current 

Overview of all the results that can be presented as a graph after performing "Nominal Torque + 

Inductance Calculation": 

 

 

Fig. 97: Overview Calculation Results 

If afterwards skewing parameters or motor length are changed, all forces and torques are also 

recalculated without the need for new FEM calculations.  
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3.6.6 Dynamic calculations  
 

Dynamic calculations can be carried out for motor start-up and steady-state operation. The calculations 

are carried out analytically in the time step method on the basis of equivalent circuit diagrams, whereby 

the inductances can also be determined in co-simulation with FEMAG. 

 

.  

Fig. 98: Motor parameters for dynamic calculation of stationary operating conditions 
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“Run Modes” 

- „Steady State“ for steady state operation 

- "Start Up" for the motor start. 

 

“Phase Parameters Info” 

- Resistors RU, RV, RW and inductors LV, LU, LW of all windings which belong to a phase 

- Induced terminal voltage 

- Moment of inertia of the rotor 

 

“System Info” 

- Line to Line BEMF (for Nominal Speed) 

- Estimated Jr 

 

“Calculation Parameters” 

- "Motor Length" 

Motor length without overhangs 

- "Skewing" 

Herewith the effects of optimization are calculated by skewing of rotor or stator. Total angle of 

inclination and the number of skew steps are indicated.  

“Skew Angle” 0 = no inclination 

 n = inclination in ° mech over the entire motor length 

“Number Of Skew Steps”  0 = no inclination 

 1 = continuous inclination on the specified angle 

 n = number of laminated cores, 

 the first laminated core is always in the position of 0 ° mech! 

 

Example: 

Skew Angle = 15 °mech 

Number Of Steps = 4  

Angular offset of the laminated cores to each other =  

15 °mech / (4-1) = 5 °mech 

- "Winding Connection" 

Winding circuit "Star" or "Delta" 

 

“Dynamics Parameters” 

- "Input Voltage" 

Maximum value of an applied constant phase voltage 

- Use Phase Voltage 

Instead of the constant phase voltage, through "Input Voltage", user-specific phase voltages can 

also be used. In this case, the phase characteristics, the amplitude and the phase angle can be 

set as needed. This function can currently only be used in "Run Mode" and "Steady State". 
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Fig. 99: Use of user-specific phase voltages 

 

With "Voltage Options" can user perform various functions to adjust voltages: 

 

 

Fig. 100: Voltage Options 

- "Initial Values":  Save, Restore 

- "FFT sampling":  Input of a value, Default = 1.000 

- "Align with BEMF":  Set to the same phase angle as BEMF 

- "Symmetric Voltage":  Setting the phases V and W as U with offset of 120 °el 

- "Phase Shift":  Input of a phase angle for all phases equal or different, per 

phase 

- "Global Amplitude Change":  Input of a multiplication factor to change the peak value of 

the voltage.  
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"Electronics" is used to specify the resistances of the transistors and diodes of the inverter in the 

equivalent circuit diagram and the time steps of the calculations. Thus, with a good approximation, any 

PWM signal can be used for the input voltage of the motor in 3-phase star connection. 

 

 

Fig. 101: Setting the parameters for the inverter model 

- "Block Commutation"  Input of electrical angle of the commutation duration 120°el 

or 180°el. 

- "Control Firing Angle Delay" Delay angle of commutation time.   

- "Stop Calculation Criteria"  Abort conditions for completing the calculations are linked 

with "or" and can be selected and parameterized. 

 

 

Fig. 102: Termination conditions for dynamic calculations 

 

Phase Parameters 

- "Added Resistance per Phase" User-specific resistance added as a constant to the phase 

resistance. 

- "Added Inductance per Phase" User-specific inductance added as a constant to the phase 

inductance. 

- "Phase Inductances" 

 "Coupled to FEMAG"  The inductances are determined for every rotor position by 

using co-simulation by FEMAG. 

 "User Defined" The inductance is calculated from the winding scheme 

independently of the rotor position and is specified as a 

constant value. 
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The calculation results are displayed as graphs. Both graphics and the numerical result values can be 

copied to other applications via the buffer (see also 0). 

 

 

Fig. 103: Dynamic calculation of the torque curve versus rotor position 

 

Overview of all the results that can be displayed as graphs after performing "Dynamic Calculation": 
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3.6.7 Postprocessing - Forces and Torque 
 

3.6.7.1 Force Calculation 
 

Basics 

 

     
 

 

 

 

 

 

 

 

Note: the force vector F must not be 

absolutely the same as the center 

point of the segment! 

 

 

 

F  =  Force Vector 

FT = tangential component of the force vector 

FN = normal (radiale component of the force vector 

FNx = x-component of the normal force vector 

FNy = y-component of the normal force vector 

 

Fig. 104: Basics of Force Vectors 
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smartFEM offers the calculation of the tangential and radial forces inside of the middle airgap layer. 

 

 

Fig. 105: Force Calculation with smartFEM 

Example: results of force calculations of a motor with centric and eccentric rotor 

  

Fig. 106: Example results of force calculations 
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For input of parameter and output of results can the window “Force Calculation“ be opened via the 

window “Motor Parameters“ and menu “Postprocessing“. Following parameter can be entered: 

- „Arc Starts on“ 

Start of the angle of the force calculations 

- „Length of Arc“ 

Length of the arc inside which the forces are calculated 
 
All angles are specified as polar-coordinates 

- „Number of Segments“ 

Number of the arc segments (each with the same length) where inside each the normal and 
tangential forces are calculated. 

- Selection „Cogging Torque“ or „Nominal Torque“ 

Selection which results of field calculations will be used for the force calculations. If „Nominal 
Torque“ is selected then are the defined currents considered. 
 

The results are displayed in a table and can be copied by the menu „Options“-→„Copy Results“ via the 
clipboard into other software programs. 
 

 

Fig. 107: Example 1 - force calculation in one segment 

 

 

 

 

 

 

 

Fig. 108: Example 2 - force calculation in five 
segments 
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3.6.7.2 Torque 
 

The calculation results of the torque in smartFEM main menu “Results“ are rounded to three significant 

digits by the FEM solver FEMAG. This leads not to accurate results when small torque ripples should 

be evaluated. Therefore the function „Postprocessing - Forces and Torque - Force Calculation“ with 

higher number of significant digits of the results is used whereby the force calculation has to be 

performed for one segment by “Arc Starts on“ = 0° and “Length of the Arc“ = 360°. 

 

 

Fig. 109: Postprocessing - Forces and Torque 

Afterwards can plots of the torque and its harmonic be displayed and evaluated. 
 

 

Fig. 110: Postprocessing - show torque graphs 

 

Fig. 111: Postprocessing - Plots of torque and its harmonic 
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Via the menu „Options - Copy Results“ can the results values of the torque and the flux density in the 

airgap be copied to a spreadsheet analysis for special user defined evaluations. 

 

 

Fig. 112: Postprocessing - selection of data to copy the results of the torque  
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3.6.8 Post Processing - Loss Calculation 
 

With smartFEM can copper, iron and magnet losses be calculated in the rotor and the stator. The 

necessary measurement and saving of basic data is accompanied by the "Nominal Torque + 

Inductance" calculation provided that beforehand the selection "Losses" in "Motor Parameters" was 

chosen.  

 

 

Fig. 113: Motor Parameters - Selection field "Losses" 

By selecting the parameter "Losses", all inductions for all network elements for each rotor position are 

stored. This results in an increased memory footprint for the motor model to follow. Thanks to this, the 

user can then calculate the losses at different speeds and the use of different materials very quickly, 

without starting the time consuming "Nominal Torque + Inductance" running calculation.  

 

After performing the calculations for "Nominal Torque + Inductance" the losses can be calculated 

through the "Postprocessing" menu. 

 

By default, in addition to this, the material data selected in the "Materials" menu are displayed in the 

window “LossCalculation”, which serve as the basis for all FEM calculations. Other materials can also 

be selected. However, the loss calculation using these materials serves only for approximate evaluation 

because the values of induction from FEM calculations with the materials selected in "Materials" are 

used. The same applies to the conductivity of the magnets in "Magnets Conductivity". 

 

 

 

For information, the values of the BH 

curve appear when the mouse points 

on the                           sign.  

 

 

 

 

 

 

 

Fig. 114: Loss Calculation - Parameters 
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Via "Speed - Add Speed Range" further speeds 

for the loss calculation can be specified.   

 

 

 

 

 

Fig. 115: Loss Calculation - Add Speed Range 

 

In addition, the number of magnetic segments in 

the axial z-direction can be assigned, which 

reduces the magnet losses caused by eddy 

currents. 

 

  

 

Fig. 116:  Loss Calculation - Magnets Segmentation  

 

 

 

 

 

 

By selection of “Extra Losses” a file *.pex with additional 

losses (for example, friction, fans, etc.) can be selected 

in case that this file was created as text file *.txt and 

saved in the material folder „…\smartFEM\Materials“. 

The separation of the columns must be the “Tab” sign. 

 Fig. 117: Loss Calculation - Example Textfile.pex 
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After pressing the "Calculate Losses" button, the 

calculations are performed. During this time the 

"Calculating" button appears.  

 

A running calculation is aborted by pressing the 

"Calculating" button. 

 

 

 

 

 

 

   
Fig. 118: Loss Calculation - Calculation Process 

 

 

The results of the loss calculation are displayed immediately after the calculation in tabular form and in 

plots:  

 

- Iron losses in the rotor  

- Iron losses in the stator  

- Magnetic losses  

- Additional losses  

- Copper losses in the windings  

- Plots with the loss densities  

- Plots with the harmonics of rotor and stator losses 

 

 

Fig. 119: Loss Calculation - Results 
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3.6.8.1 Polynomial Coefficients  

 

For the loss curves, the coefficients (xy and invers yx) of polynomials 3rd to 7th order can be calculated 

and copied over the clipboard to create mathematical loss models in other applications. 

 

 
 

 

Fig. 120: Loss Calculation - Polynomial coefficients 

 

3.6.8.2 Loss Calculation of Linear Motors 

 

The calculation of losses are generally performed by using “Fourier Transfomation”, which are only valid 

for periodic signals. Therefore are the losses of linear motors only for periodic models with negative or 

positive periodicity performed. In smartFEM available non-periodic models can the userselect by a 

switch whether the model shall be 

periodic or non-periodic. 

As far as modesl of linear motor are 

designed by using CAD software and 

imported as DXF file into smartFEM the 

user has to take this into account.  

 

 

 

 

 

Fig. 121: Loss Calculation - Linear Motors 
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3.7 Ld/Lq identification  

 

For a field-oriented control of permanent magnetically excited synchronous motors, the tables of Ld and 

Lq identifications, which are determined by the Park/Clarke transformation, are often used. These tables 

can be calculated in smartFEM using the "Ld/Lq" function. The first step is to create a table with fluxes 

and their phase shifts. This can be done manually line by line or parametrically via the dialog "Data - 

Add - ..." or parameterized. This table is generated automatically for the simulation of a field-oriented 

control with the program "CASPOC" suitable for the simulation of power electronics. 

 

 

Fig. 122: Ld / Lq - Creation of data records 

The records can be calculated individually or all automatically after pressing the "Solve All" button. 

 

 

Fig. 123: Ld / Lq result table 
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Various diagrams can then be output to the result table. 

 

 

Fig. 124: Ld/Lq - Diagram Torque vs. Theta with is = constant 

 

The phase diagram can be displayed for each selected table line. 

 

 

Fig. 125: Ld/Lq - Phase diagram 

The results table can be transferred and used in other software programs via clipboard by "Options - 

Copy Sets". 
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A result table generated for the CASPOC 

program is stored in the xml formatted file 

via the "Data Caspoc Export File" dialog, 

which is used by CASPOC as a look-up 

table for electronic simulation. 

 

Fig. 126: Ld / Lq - Creation of a result file for CASPOC 
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3.8 Calculation of Special Effects  

 

For the calculation and investigation of specific effects (for example, the resting moment caused by a 

single magnet), it is possible to assign different material properties to individual surface elements, like 

for example:  

 

 

Fig. 127: Simulation model with a magnet 

Note:  

As a result of this, the motor model no longer satisfies 

the periodic symmetrical conditions specified by the 

number of magnets and slots in the rotor and stator 

topology. The results therefore only refer to this 

special case and cannot be transferred to the 

complete periodic simulation model. User is asked 

for acknowledgement in a pop-up-window. 

 

 

The change in the material properties of individual surface elements is achieved by clicking on the 

corresponding surface element with the left mouse button in the representation "Geometry" or "Material" 

while simultaneously pressing a key combination "CTRL", "ALT", "Shift": 

 

o CTRL  →  Rotor Iron 

o ALT  →  Stator iron                            

o ALT + Shift  →  Magnet  

o ALT + CTRL  →  Air 

 

Fig. 128: Change of the material properties of individual surface elements 

When using this function, it is important to know that when this function is being performed, all results 

will reset, and the question pops up whether an "entire" motor model is to be built up. 
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3.9 Graphical display and evaluation of results 

 

The results are displayed automatically in a new window in graphics form after a calculation is started 

by clicking on the "Calculation" button and performed. If calculations have already been carried out, this 

is indicated by the "Results" button in the upper menu line. By clicking on this button, the window with 

the graphics is shown. 

 

The individual graphics are selected by clicking on the corresponding line in the menu of the graphics 

window on the right side. When a check sign is set in a square, the corresponding graphic is 

automatically included in the report when the project report is generated. 

 

The "Options" menu allows you to copy graphics as well as the calculated values via the buffer to other 

applications and to edit them there.  

 

 

Fig. 129: Graphical display and evaluation of the results 

3.9.1 Results 
 

The calculation results are displayed as graphics after clicking the "Results" button. Both graphics and 

values can be copied to other applications via "Options" → "Copy Picture" or "Copy Data". The 

following graphics can be displayed: 

 

3.9.1.1 Cogging Torque and BEMF 

 

• Cogging Torque + BEMF 

 

- Cogging moment and harmonic 

- Flow per phase without/with current and harmonic for phase U 

- Inductance per phase 

- BEMF per phase/string and harmonic for phase U/UV 

- ke per strand 

 

• Expected values as an analytical calculation of the expected values for 

 

- Expected motor torque 

- Cogging Torque 

- Phase current, phase-element current 

- BEMF per phase 
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3.9.1.2 Nominal Torque and Inductance 

 

The following calculation results can be displayed: 

 

• Nominal Torque + Inductance 

The values are calculated at rotor positions within a BMEF period with the step size specified in 

"Motor Parameters". 

 

- Torque 

- Cogging Torque 

- Reconstructed Cogging Torque 

(transformation of the results for the cogging torque at rotor 

positions of torque to the rotor positions within the cogging torque 

period) 

- Phase current, line-to-line current 

- Flux per phase without/with current and harmonics of phase U 

- Inductance per phase 

- BEMF per phase/line-to-line and harmonics of phase U/UV 

- ke, kt per line-to-line 

- Terminal voltage per phase/ line-to-line and harmonics of phase U/UV 

- Transformer voltage per phase and harmonics of phase U 

 

 

3.9.1.3 Dynamic 

 

The following graphics can be displayed in detail: 

 

• Dynamic Calculation 

- Cogging torque 

- Magnetic flux without current 

- Phase currents 

- Inductors 

- BEMF 

- Magnetic flux with current 

- Number of revolutions 

- Strand currents 
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3.10 Saving and loading simulation models 
 

Via the menu sequence "File -> Save" and "File Save As" the simulation models can be stored in any 

directory. The directory specified in the smartFEM Settings is displayed as the default folder. All 

parameter values and results are stored in a "modellname.mot" file. Thus, each simulation model is 

consistent in itself. Additionally, the used topology and material files are also stored. 

 

There are several ways to open simulation models: 

 

• "File -> Open" 

The location of the model can be selected and the model opened. The topologies contained in the 

topology directory are automatically loaded. If parameter values (dimensions, node densities, etc.) 

should not be displayed correctly in newer versions of the topologies, the model can also be opened 

with the topologies stored in the model. 

 

 

Fig. 130: Open a previous saved simulation model 

• With "Ctrl + #" the corresponding simulation model is opened directly. The last four stored model 

files and their paths are displayed. 
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4 Add-ons 
 

Add-ons are special modules that are created as the dll file type and stored in the “... \ smartFEM \ 

ElTopology” directory. They are recognized and listed dynamically by smartFEM when the "Add-ons" 

menu is selected in "Motor Parameters". Users can also create their own dlls, if they know the interface. 

 

 

Fig. 131: Add-ons - Call-up menu 
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4.1 Motor Diagrams 
 

The "MotorDiagrams" module is a special module, with which motor diagrams with different graphics 

such as "Torque-speed-diagram" can be generated. The basis for this is an Ld/Lq matrix, whereas the 

results of individual Ld/Lq sets in mathematical models with polynomials can be used for creation of 

diagrams.  

 

The call up of the module motor diagrams is made in "Motor Parameters" via the "Add-Ons - 

MotorDiagrams" menu. 

 

 

Fig. 132: Motor diagrams - Call up 

 

 

The calculations for generating different graphics are performed on the basis of a current-theta matrix 

specified by the user. 

 

From the current theta matrix, corresponding sets are generated for the Ld/Lq calculations. In addition 

to the Ld/Lq identification, different additional results are calculated for each Ld/Lq set. 

 

 

Fig. 133: Motor diagrams - Current theta matrix and result values 
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In the "Diagram" screen, the 

parameters for generating the graphs 

are computed with the calculation of 

the graphs to be displayed.  

 

The winding connection "Star/Delta" is 

automatically taken over from the 

parameter specification in the "Motor 

Parameters". 

 

If "0" (zero) is entered, the respective 

values are taken from the results of the 

Nominal Torque Calculation and the 

Motor Parameters and displayed. 

 

 

 

 

 

 

 

 

 

 
Fig. 134: Motor diagrams - Parameters for the calculation of the graphic data 

 

When Input Voltage = DC is selected, the corresponding "Input Voltage Line to Line RMS" is determined 

from the input value UsDC and used for the calculations of the motor diagrams: 
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Fig. 135: Motor diagrams - Conversion of UsDC <> UsLL_rms 
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The parameters for currents and phase shifts from which the Ld/Lq sets are generated for the calculation 

of result values of the theta current matrix are entered in the "LdLq Sets" screen window. The "Simple" 

type is used to calculate simple motor diagrams for individual operating points. 

 

 
 

Fig. 136: Motor diagrams - Parameters for the creation of the Ld/Lq sets 
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For calculation of losses, the required parameters can be entered in the window „Loss Sets“. 

 

 

Fig. 137: Motor diagrams - Loss sets 

A "Nominal Torque + Inductance Calculation" is carried out per Ld/Lq set with subsequent calculation 

of the losses. 

 

After calculating the losses, these are read from the individual model files and are also stored in the 

"basic" model file. „Re-Read Loss Data from Mot Files = Yes“ is used to read the loss data from the 

model files. 

 

A model file (mot-file) is created with the entered data for each Ld/Lq set and stored in the directory 

specified in "Working Folder". If the character "" is indicated, the directory is used in which the "base" 

model opened with smartFEM is also stored. The respective filenames are supplemented by the Ld/Lq 

parameters Is and Theta for distinction. 

 

 

Fig. 138: Motor diagrams - Example of folder contents with "Base" and "Loss" models 
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4.1.1 Performing calculations 
 

By clicking the button, the generation of the motor diagrams is triggered and carried out in the following 

steps: 

 

Step 1:  Sequential generation of the Ld/Lq sets from the data specified in the parameter window 

„Ld/Lq Sets“. It checks whether the set is already contained in the Ld/Lq table which can be 

called in the smartFEM main window via the „Lq-Lq“ button and has already been calculated. 

If this is not the case, the set is inserted into the table and the calculation of this set is 

started. 

 

Step 2:  When all Ld/Lq sets are calculated, the loss calculations are started (i.e. generation of the 

model files (mot files) per Ld/Lq set and execution of the „Nominal Torque + Inductance 

Calculations“ with subsequent calculations of the losses Parallel processes corresponding to 

the number of processor cores to be used. 

 

In the window „smartFEM MultiRun“ an overview of all Ld/Lq sets and their current state with 

regard to loss calculations is displayed. Here, the number of processor cores to be used can 

also be adapted from 1 to maximum of the cores present in the particular computer. 

 

 

Fig. 139: Motor diagrams - smartFEM MultiRun with overview of the current processing status for the loss 
calculations 

The smartFEM processes started with “MultiRun” run automatically with a lower priority than the 

”smartFEM-Master- Process" in order not to block it.  
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Step 3:  After completion of step 1, the motor diagrams are generated parallel to the calculation of the 

losses. They can be edited by the user and are automatically complemented after the losses 

have been calculated. 

 

The values entered in the parameter window "Diagram" are based on: 

 

- Input Voltage Line to Line or DC 

- Motor Speed for calculating the minimum voltage Input Voltage Line to Line 

- Electronic Current Limiter for current limitation. This serves only for the optical 

delineation of the operating range, which can be achieved by the maximum motor 

current. 

 

The following diagrams are generated: 

 

 

Fig. 140: Motor diagrams - Diagram types 

 

 

4.1.2 Diagram examples 
 

4.1.2.1 Torque vs. number of revolutions 
 

 

Fig. 141: Motor diagrams - Torque vs. torque number of revolutions 
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The data entered in the parameter window "Diagram" can be changed after creating the diagrams with 

the help of slides shown in the diagram windows, whereby the diagrams are updated immediately. 

 

The dotted lines represent the curve progressions after deduction of the iron, magnetic and external 

losses. 

 

 

Fig. 142: Motor diagrams - Torque vs. Speed with air gap torque (Tag) and output torque (Tout) 

 

 

By use of the middle mouse button or the scroll wheel individual graphs or groups can be highlighted. 

 

 

Fig. 143: Motor diagrams - Example of highlighting a single graph 
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Each graph can be detached from the tree diagram for user-specific placement on the screen. 

 

 

Fig. 144: Motor diagrams - Example for "Undock Graph" 

 

 

Fig. 145: Motor diagrams - Example for "Undock Graph" 
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In some diagrams, graphs are also available for minimum values of current and voltage. 

 

 

Fig. 146: Motor diagrams - Minimum values of the voltage as a function of the current 

 

4.1.2.2 Efficiency diagrams as contour plots 
 

Two different contour plots are generated to evaluate the efficiency as a function of torque and speed: 

 

Fig. 147: Efficiency with minimum current     Fig. 148: Maximum efficiency 
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The diagrams of the respective mouse position 

are shown in the status line, e.g. X = 336rpm, y = 

331Nm, η = 97.3%. 

 

 

 

 

 

 

Fig. 149: Motor diagrams - Diagram values at the 
mouse position 
 

 

 

By clicking the right mouse button on the plot, different settings can be made for the plot. The name 

"Efficiency" cannot be changed and it is used only for smartFEM internally. 

 

 

 
Fig. 150: Motor diagrams - Settings for contour plots 
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4.1.2.3 Torque Speed Feed Loop Table (MTPA - Maximum Torque per Ampere) 
 

For the determination of the feed setting parameter Us, Id/Iq, Ld/Lq and Theta of the motor in 

dependence of torque and speed with minimum current are the results via the menu Menu „Options - 

Copy Torque Speed Feed Loop Table“ calculated.  

 

 

Fig. 151: MotorDiagrams - Copy Torque Speed Feed Loop Table 

When the ”Torque Speed Feed Loop Table“ is calculated then are the result data available in the 

clibboard and can be copied into other applications. 

 

 

Fig. 152: MotorDiagrams - Torque Speed Feed Loop Table 
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Additional to that is then in „MotorDiagrams Graphs“ the Plot2D „Efficiency Torque Speed Loop Table“ 

available. 

 

 

Fig. 153: MotorDiagrams - Plot2D "Effiency Torque Speed Feed Loop Table" 
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4.1.3 "Simple" motor diagrams 
 

For a quick assessment of motor properties in individual operating points, "simple" motor diagrams can 

be generated. For this purpose "Simple" must be selected in the parameter group "Ld/Lq Sets", in order 

to enter the data for the corresponding operating point. 

 

 

 

 

 

 

 

 

 

 

 

 

The following diagrams can be 

generated: 

 

 

Fig. 154: Motor diagrams - Parameter input for "Simple motor diagrams" 

 

 

Fig. 155: Motor diagrams - Example "Simple" motor diagram Us vs. Is with Speed = constant 
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4.2 Motor control 
 

The "MotorControl" add-on is used to generate data for the motor control electronics. After entering the 

calculation parameters, the unsolved Ld/Lq sets are checked and the corresponding calculations are 

then performed. 

 

Fig. 156: Motor Control - Entering the calculation parameters 

Different plots are generated, and the results can be stored both in the clip board and in a file.  

 

                   

Fig. 157: Motor Control: Diagrams types                    
Fig. 158: Motor Control - Result memory 

 

 



 
  
 

  

 107 

smartFEM 

Diagram examples: 

 

  

Fig. 159: Motor Control Diagram "Flux Linkage Magnet vs. Is"  
Fig. 160: Motor Control - Contour Plot "Torque vs. Theta vs. IS" 

 

 

Fig. 161: Motor control- Results data 
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4.3 General Contour Plots 
 

The Add-On "ContourPlot" is used to create contour plots from any data compiled by the user. 

 

The data of a contour plot must be stored in a tabular text file (* .txt with tab delimited columns or csv 

format). The first cell contains plot, column, and line names each separated by "\". 

 

Fig. 162: Contour Plot - Tabular text file 

 

A single text file or a directory can be selected to generate the plots. When a directory is specified, plots 

of all the files contained in the directory are generated. 

 

 

Fig. 163: Contour Plot example "Efficiency vs. Current vs. Speed" 
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4.4 AC-Losses 

 

Determination of the Alternating Current Losses in stator winding which are caused by “Skin” and 

“Proximity” effects mainly in big electrical machines. The calculations are based on the analytical 

algorithms which are documented in "Skin Effect in Large Polyphase Machines with Concentrated 

Windings" by Falk Laube, Helmut Mosebach und Wolf-Rüdiger Canders. 

 

The geometry of the stator slots and wires is assumed as rectangular. The type of winding can be single 

layer or double layer side by side respective on top of each other: 

 

 

Fig. 164: AC-Losses - Geometry of slot and widings 

The module is started in “Motor Parameters” by menu sequence „Add-ons - AC_Losses“. In the Tab 

“Basic” selected whether the parameter which are necessary for the calculations are entered manually 

or taken over from the actual opened smartFEM machine model. 

 

 

Fig. 165: AC-Losses - Source of Parameter 

Hereinafter are parameter of a big machine model used which possesses nearly rectangular stator slots. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 166: AC-Losses  - smartFEM model 
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The data which are taken from the smartFEM model are displayed in green colour and cannot be 

changed. Some necessary parameters are not defined in the smartFEM model and the related values 

have to be determined or estimated by the user and entered manually. 

 

In Tab “Geometry” are 

these the parameter: 

 

- Width of slots 

- Number of 

conductors on 

top of each 

other 

- Number of 

conductors 

side by side 

 

 

 

Fig. 167: AC-Losses - Geometry Parameter "smartFEM Model" 

In case that in Tab “Basic” as „Source of Parameter” „Input Data“ is selected all parameter except 

„Number of Turns“  have to be determined and entered manually. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 168: AC-Losses - Geometry Parameter "Input Data" 

“Material” Parameter: “Conductivity at winding temperature” is taken from “Material” parameter of the 

smartFEM model. By specification of “Conductivity at 20°C“ the temperature of the winding is re-

calculated with which the smartFEM model was calculated. 

 

 

 

 

 

 

 

 

 

 

Fig. 169: AC-Losses - Material Parameter "smartFEM Model" 
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In case that in Tab „Basic“ as „Source of Parameter” „Input Data“ is selected, can the temperature of 

the winding entered at which the AC-Losses shall be calculated. The conductivity for this temperature 

is then re-calculated.  

 

 

 

 

 

 

 

 

 

Fig. 170: AC-Losses - Material Parameter "Input Data" 

„MotorParameters“ are always taken from the smartFEM model and provided as information for the 

user. 

 

 

 

 

 

 

 

 

Fig. 171: AC-Losses - Motor Parameter 

In the tab „AC-Resistance & Losses“ are the results of the AC-Resistances of the windings and the AC-

Losses displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 172: AC-Losses - Results 
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Remark: 

 

• By the reason of the analytical model and the in part not correct geometrically dimensions of 

slot and conductors in relation to the smartFEM model represent the results only rough 

approximation values which are afflicted with certain errors. For more accurate results are 

transient calculations required. This is not possible because the actually used FEM solver 

FEMAG only provides 2D-Simulation the electro-magnetic fields. 
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5 Simulation in Batch Mode 
 

Batch files enable the sequential and parallel execution of several simulations The respective 

command lines for the simulations to be performed can be generated with a text editor. No specific 

order of parameters is prescribed. 

 

5.1 Example of batch file with sequential execution of the simulations 
 

ECHO OFF 

ECHO smartFEM Batch Mode running, press "CTRL+C" to stop Batch Mode  

 

REM smartFEM Batch Commands for smartFEM Release 2.7.0 and higher 

REM  

REM  [c:\...\]smartFEM.exe [help | /help | /?] [C:\...\]filename.mot -parameter 

REM  

REM If smartFEM.exe and/or mot-file are stored in the folders assigned with  

REM smartFEM settings, then the complete paths are optional. 

REM 

REM To display this file as help text [help|/help|/?] can be used. 

 

REM Parameter: 

REM 

REM "filename.mot" must be the first parameter, others can be in random sequence. 

 

REM General options: 

REM 

REM -log           Text file with log information will be saved with name "filename.log"  

REM   in the same folder as the mot-file . 

REM 

REM -hidefemag FEMAG windows will be closed and not shown. 

REM 

REM -multi1|-multi2|... FEMAG will run on CPU (or Core) 1|2|... 

 

REM Preprocessing options: 

REM 

REM -top   Load mot file with rotor and stator topology saved in mot-file. 

REM 

REM -toprotor   Load mot file with rotor topology saved in mot-file. 

REM 

REM -topstator   Load mot file with stator topology saved in mot-file. 

REM 

REM -dxf   Refreshing of both rotor and stator dxf-files is performed.  

REM 

REM -dxfrotor   Refreshing of rotor dxf-file is performed. 

REM 

REM -dxfstator   Refreshing of stator dxf-file is performed. 

REM 

REM -nophaseshiftcalculation no phase shift calculation will be performed 

 

REM Calculation options: 

REM 

REM -cogging         Cogging Torque + BEMF Calculation. 

REM 

REM -nominal         Nominal Torque + Inductance Calculation. 
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REM 

REM -is400:-40 Current sine exitation is_rms=400A and Phase_shift_theta=-40°el 

REM 

REM -iq306:-257 Current sine d/q excitation with iq_rms=306A and id_rms=-257A 

REM 

REM -ldlq  Calculation of user defined Ld/Lq sets. 

REM 

REM -losses  Calculation of losses with smartFEM "Operational Speed" and  

REM   Speed Range defined inside "MotorParameters-Postprocessing-Losses", 

REM   loss results and loss data are saved. 

REM 

REM -onlylossresults    Same as "-losses" but only loss results are saved. 

REM 

REM -ls=100[:200:300:...] Calculation of losses at different speed with named speed 

REM    -ls=FirstSpeed and optional :SecondSpeed:ThirdSpeeed:etc.  

REM 

REM -lsr=0:3000:11  Calculation of losses at different speed with speed range 

REM    -lsr=FirstSpeed:LastSpeed:NumberOfSteps. 

REM 

REM -lextra filename.pex              Recalculation of extra losses defined in file.pex in Material folder 

REM 

REM  -force=0:180:2:stator calculate forces from Nominal Torque + Inductance Calculation   

REM    in "Motor Parameters - Post-Processing - Forces & Torque"  

REM          -force=arc starts on:length of arc:number of segments:segments relative to stator|rotor 

 

REM Calulation results options: 

REM 

REM -export   Run batch command and export results from mot-file  

REM    to text file with name "filename.txt". 

REM 

REM -export exportfilename.txt Export of results to user defined "exportfilename.txt" file. 

REM 

REM -export folderwithmotfiles  Run all batch command and export of results from each mot-file 

REM    inside folder "...\folderwithmotfiles" to "FolderResults.txt" 

REM    saved in the same folder. 

REM 

REM -exportonlyoverview        Run batch command and export only overview table results  

REM    of the mot-file to text file with name "filename.txt" 

 

REM Saving options: 

REM 

REM -save [newmotfilename]   Open mot-file, refresh results and save motfile optional  

REM     with new mot-file name. 

REM 

REM -savenominaldone [newmotfilename]   as "-save" but with extra check whether nominal  

REM     torque calculation is already performed. If not will  

REM     it be performed. 

 

REM Remarks: 

REM 

REM  If the path of smartFEM.exe or mot-file contains " ", then must the path be included by  

REM  quotation marks. 

 

REM         e.g.:  D:\smartFEM\smartFEM.exe D:\elmoCAD\temp\Motor Design.mot >> 

REM D:\smartFEM\smartFEM.exe "D:\elmoCAD\temp\Motor Design.mot" 



 
  
 

  

 115 

smartFEM 

REM 

REM Preprocessing will be automatically performed if required. 

REM  

REM Nominal Torque Calculation will be automatically performed if losses option is selected. 

REM   

REM ! For correct Nominal Torque results phase angle between BEMF and 

REM ! Current has to be checked before calculations are performed, when  

REM ! Sinusoidal or User Defined Current is selected. 

REM 

REM the results are stored in the selected file. 

REM 

REM for stop of calculations press "CTRL+C". 

 

REM Examples: 

REM Perform cogging calculation and write messages to log. 

REM D:\elmoCAD\smartFEM\smartFEM.exe D:\elmoCAD\temp\MotorDesign.mot -cogging 

REM 

REM Perform nominal calculation and calculate losses for speed 7000 rpm 

REM D:\elmoCAD\smartFEM\smartFEM.exe D:\elmoCAD\temp\MotorDesign.mot -nominal -ls=7000 -log 

REM 

REM Perform cogging and nominal calculation, calculate losses for speed 0rpm in steps of 1000rpm  

REM until 7000rpm in steps of 1000rpm for all mot files inside modelfolder and export results to  

REM "FolderResults.txt" 

REM D:\elmoCAD\smartFEM\smartFEM.exe D:\elmoCAD\temp\modelfolder\ -cogging -nominal  

REM -losses -lsr=0:7000:8 -export  

 

PUSHD 

ECHO ON 

 

...\smartFEM.exe "...\ModelFolder\MotorDesign.mot" -cogging -log 

 

ECHO OFF 

POPD 

PAUSE 

 

 

 

Fig. 173: Parameter settings - Sample batch file 

If the mot files are stored in the “temp” directory specified with "smartFEM Settings", the path data can 

be omitted. 

 

The "Preprocessing" function is performed automatically if necessary. 
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After starting the batch file, a DOS window is opened, in which the process is documented. 

 

 

Fig. 174: Parameter settings - Sample Batch log file 

The DOS window is closed after all command lines have been executed, unless the DOS command 

"Pause" is used in the last command line. The messages sent by smartFEM to the Dos window are 

stored in a log file if the -log parameter is used. 

 

5.2 Exporting result data to a text file 
 

The result data displayed in "Results" are exported to a text file using the batch command "-export", 

which in turn can be opened in a spreadsheet for further individual calculations. There are two options 

for export: 

 

• Export the results of one machine model (* .mot file) 

Command:  c: \ ... \ MotorVarianten \MotorDesign1.mot -export c: \ ... \ MotorDesign1_Results.txt 

If no path is specified, the export file is stored in the directory where the mot file 

is located. 

 

• Export the results of all machine models inside the folder Command: 

Command:  -export c: \ ... \ Motorvarianten Exported_Results.txt 

In this example, the results of all machine models located in the c: \ ... \ MotorVarianten 

directory are exported to Exported_Results.txt. 

 

 

Fig. 175: Batch simulation- Exported result file 
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5.3 Parallel Computing 
 

If several processor cores are present on a PC, different calculation runs can be distributed to the 

existing processor cores for parallel processing. Thus, a considerable amount of computation time can 

be saved, especially when, for example, a Nominal Torque Calculation takes several hours. 

 

As exemplary templates, there are two batch files in the batch directory ...\smartFEM\. 

 

5.3.1 _Batch_MultiRun.bat 
 

Here, as in Batch.bat, the calculations are determined and it is defined on which processor core they 

are to run: 

 

echo off 

rem smartFEM calculations with different mot-files, whereby parallel 

rem computing on the existing CPU's or Core's of the PC is performed 

rem 

rem This batch must be started via _Batch_MultiRunStart.bat 

rem 

. 

. 

. 

rem Nominal Torque calculation will be automatically performed before 

rem calculations if necessary. 

. 

. 

. 

rem example: 

rem            motfile-1 ... motfile-4 are running parallel on 4 cores 

rem            motfile-5 ... motfile-8 are running parallel on 4 cores 

rem 

rem            motfile-5 is running in sequence after motfile-1 is finished 

rem            motfile-6                     “                     motfile-2        “ 

rem            motfile-7                     “                     motfile-3        “ 

rem            motfile-8                     “                     motfile-4        “ 

 

set exepath=C:\Users\elmoCAD\smartFEM 

set motpath=C:\Users\elmoCAD\Temp 

 

set motfile-1=MotorDesignTemp_1.mot 

set motfile-2=MotorDesignTemp_2.mot 

set motfile-3=MotorDesignTemp_3.mot 

set motfile-4= 

 

set motfile-5= 

set motfile-6= 

set motfile-7= 

set motfile-8= 

 

if %1 == -multi1 goto :CPU1 

if %1 == -multi2 goto :CPU2 

if %1 == -multi3 goto :CPU3 

if %1 == -multi4 goto :CPU4 

 

Goto :End  
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rem *********** 

:CPU1 

echo mot-file running on CPU1 

echo on 

%exepath%\smartFEM.exe -nominal %motpath%\%motfile-1% %1 -log -hidefemag 

%exepath%\smartFEM.exe -nominal %motpath%\%motfile-5% %1 -log -hidefemag 

 

Goto End 

 

rem *********** 

:CPU2 

echo mot-file running on CPU2 

echo on 

%exepath%\smartFEM.exe -nominal %motpath%\%motfile-2% %1 -log -hidefemag 

%exepath%\smartFEM.exe -nominal %motpath%\%motfile-6% %1 -log -hidefemag 

 

Goto End 

 

rem *********** 

:CPU3 

echo mot-file running on CPU3 

echo on 

%exepath%\smartFEM.exe -nominal %motpath%\%motfile-3% %1 -log -hidefemag 

%exepath%\smartFEM.exe -nominal %motpath%\%motfile-7% %1 -log -hidefemag 

 

Goto End 

 

rem *********** 

:CPU4 

echo mot-file running on CPU4 

echo on 

%exepath%\smartFEM.exe -nominal %motpath%\%motfile-4% %1 -log -hidefemag 

%exepath%\smartFEM.exe -nominal %motpath%\%motfile-8% %1 -log -hidefemag 

 

Goto End 

 

rem *********** 

:End 

Pause 

 

 

The batch must be adapted according to the number of processor cores available on the respective 

PC.  

 

This batch must be started by batch file “_Batch_StartMultiRun.bat” 
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5.3.2 _Batch_StartMultiRun.bat 
 

Batch calls up the previously described _Batch_MultiRun.bat batch several times according to the 

defined number of processor cores, without waiting for the complete execution. The respective 

processor cores to be used are transferred as parameters. 

 

The batch must also be adapted with regard to the available number of processor cores of the PC. 

 

echo off 

rem smartFEM calculations with different mot-files, whereby parallel 

rem computing on the existing CPU's or Core's of the PC is performed 

rem 

rem This batch will start _Batch_MultiRunStart.bat where mot.files and 

rem CPU's have to be assigned 

rem 

 

pushd 

 

start /min C:\Users\elmoCAD\Temp\_Batch_MultiRun.bat -multi1 

start /min C:\Users\elmoCAD\Temp\_Batch_MultiRun.bat -multi2 

start /min C:\Users\elmoCAD\Temp\_Batch_MultiRun.bat -multi3 

start /min C:\Users\elmoCAD\Temp\_Batch_MultiRun.bat -multi4 

 

popd 

exit 

 

 

5.3.3 smartFEM 
 

smartFEM can also be started with the following command on a specific or several processor cores: 

 

smartFEM.exe -multi # (# = number of the processor core) 

 

With this is also parallel computing simulation possible. 

 

 

Fig. 176: Parallel Computing - Assignment of processor cores  
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6 Special modules 
 

6.1 PM - Magnetization - Inner rotor 
 

The motor type "PM - Magnetization - Inner Rotor" is used to simulate the magnetization and the 

remanence of the magnets of a rotor. They are equipped with non - magnetized magnetic material and 

subsequently magnetized by means of a magnetizing coil. Two methods are implemented for the 

calculation of remanence: a) FEM calculation with FEMAG and b) analytical calculation, which can be 

used if the iron core of the magnetization coil is not made of sheet material and very high eddy currents 

occur. 

 

Any rotor that can be selected in smartFEM can be used for internal rotors. In the first step, the rotor is 

modeled as usual with the corresponding topology. 

 

6.1.1 Rotor and magnetizing coil 
 

For the modeling of the magnetizing coil, a corresponding topology of the stator "MD ... .top" is included 

in smartFEM. The number of slots corresponds automatically to the number of magnets defined in the 

rotor. 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 177: PM magnetization - Example of Magnetizing 
device (coil and rotor) 

A material file, which contains a new curve 
of the "Soft Iron" magnetic material in the 

first quadrant as the B (H) curve, must be selected as the 
magnetic material in "Material". 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Fig. 178: PM magnetization - Initialization  

Fig. 179: PM-Magnetization - Magnet Material 
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The data for a corresponding new curve B(H) can be recorded using the material Explorer or 

PowerCore® Explorer contained in smartFEM.  

 

 

Fig. 180: PM magnetization - new curve of a neodymium iron boron material 

In "Motor Parameters" the data for magnetization simulation are specified subsequently: 

 

- Min. Rotation Step: minimum step angle for the rotation of the rotor 

- Convergence Accuracy: abbreviation criterion for FEMAG interactions 

- Magnetization Current: amplitude of the magnetization current 

- Remanence by: FEMAG: the remanence induction is determined by FEMAG 

  MEXFile: the remanence is specified in a "Magnetization 

Activation” table. 

- Nominal Remanence Brem: nominal remanence at the chosen current 

- Anisotropy Mode: isotropic or anisotropic 

 

 

 

Fig. 181: PM magnetization - Motor parameters 
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The simulation is started by pressing the "Run Magnetization" button,. 

 

 

Fig. 182: PM magnetization - Start of the simulation with "Run Magnetization" 

The simulation results can be displayed and edited as usual in “Plots”, e.g.: 

 

 

 

 

 

 

 

 

 

Fig. 183: PM magnetization - Induction distribution 

 

 

 

 

 

 

 

Fig. 184: PM magnetization - Remanence in the 
ring magnet (zoomed) 

 

The induction, which is actually reached in air at a certain distance from the magnetic surface, can be 
calculated and displayed as a * .mot file in a second step after saving the simulation model. 
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6.1.2 Calculation and evaluation of air gap induction and remanence 
 

To assess the magnetization, the air gap induction of pre-magnetized rotors can be calculated and 

displayed using a "measuring ring" stator topology (Messring). For this purpose, the previously stored 

simulation model of the pre-magnetized rotor is loaded in the rotor topology of a new model through the 

dialog "File - Load Magnetization". 

 

 

Fig. 185: PM magnetization - Charging a pre-magnetized rotor model 

Additionally, the stator topology "CS01_Measure_Ring_Magnetization" is selected and correspondingly 

parameterized so that it corresponds to a device for measuring the remanence induction of the magnets. 

The distance between the measuring probe and the magnet must be equal to the distance of the middle 

air gap, so that measurement and simulation results can be compared. If the measurement is carried 

out in air, the thickness of the stator ring should be a multiple of the rotor radius in order not to limit the 

field propagation in the air by boundary conditions of a ring that is too narrow.  

 

 

Fig. 186: PM magnetization model for simulating the induction on the rotor surface 
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The simulation is started with the "Calculation" button. Additionally, the results (like for example the 

calculated air gap induction) can be calculated both with the "BField" plot as well as with "Postprocessing 

- Forces and Torque - Calculate" in "Motor Parameters". 

 

 

Fig. 187: PM magnetization - Induction distribution plot 

The remanence induction of the magnets corresponds to the evaluation shown in Fig.112. 

 

The values of the air gap induction (radial and tangential) can be copied via the buffer to a spreadsheet 

for further evaluations through "Options - Copy Airgap B-Field Values to Clipboard". 

 

 

Fig. 188: PM magnetization - Calculating air gap induction by Post-Processing 
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Fig. 189: PM magnetization - Air gap induction evaluated in spreadsheets  

 

6.1.3 Use of pre-magnetized rotors in motor models 
 

The simulation models of pre-magnetized rotors saved as * .mot file can be used in motor models. For 

this purpose, the corresponding rotor model is loaded in the rotor topology via the dialog "Options - Load 

Magnetization" (see Fig. 113). 

 

The geometry parameters of the rotor and the magnetic material can no longer be changed. If necessary, 

this must be done as in Tx. 6.1.1 and the rotor can be magnetized again. 

 

All other functions for the simulation of the motor model with pre-magnetized rotor are available as usual. 

 

 

Fig. 190: PM magnetization - Motor model with biased rotor 
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6.2 PM DC Brushed Motor 
 

The creation of a simulation model PM DC Brushed Motor is initialized via "File - New - Select Motor 

Type". The topologies correspond to those of the outer rotor motors. At least one PM-BDLC outer rotor 

topology (* .top) must be stored in the topology directory in order for menu item "PM DC Brushed Motor" 

to be displayed. 

 

  

Fig. 191: PM DC Brushed Motor initialization 

All outer rotors and stators can be selected. 

 

 

Fig. 192: PM DC Brushed Motor - Example of a geometry model 
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The Winding Editor generates automatically a winding scheme which also can be edited by the users 

and it provides the possibility to create different Phasor Diagrams 

 

 

Fig. 193: PM DC Brushed Motor - Winding Scheme and Phasor Diagrams 

Winding Scheme, coil parameter, line to line definition and commutation sequence can be adapted 

manually. 

 

 

Fig. 194: PM DC Brushed Motor - Commutation Sequence 

The position of the brushes to the segments of the commutator are defined in “MotorParameters“. 
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Fig. 195: PM DC Brushed Motor - Brush position  
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6.3 Synchronous Motor (external excited) 
 

The simulation model of an externally excited "Synchronous Motor" is initialized by the menu sequence 

„File - New - Select Motor Type“. The stator topologies which can be selected are the same as for “PM 

BLDC - Inner Rotor” motors. At least must one rotor topology (*.top file) with external excitation be saved 

in the smartFEM topology folder so that the menu item „Synchronous Motor“ is displayed. 
 

 Fig. 196: Synchronous Motor with 4 poles 

 

Fig. 197: Synchronous Motor - Initialization 

The conductivity of the rotor coils can be 

defined in „Material“. Default value is 

56000000 S/m.  

 

 

 

 

Fig. 198: Synchronous Motor - Material Settings 

 

The parameter of rotor and stator windings can be defined separately. 

 
Fig. 199: 

Synchronous 

Motor - 

Windings 
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The excitation of the rotor is defined as 

constant current in „MotorParameters". 

 

 

 

 

 

 

 

 

Fig. 200: Synchonous Motor - Rotor Coil Excitation 

 
All calculations as of “PM BLDC ...” motors except „Cogging 
Torque + BEMF Calculation“ can be performed. 
 
 
 
 
 
 

Fig. 201: Syncronous Motor - 
Calculation Types  

The BEMF has to be calculated separately in an extra smartFEM model by „Nominal Torque + 
Inductance Calculation“ with rotor current Ir > 0 A and stator current Is = 0 A . 

  

Fig. 202: Synchronous Motor - Coils Excitation  
Fig. 203: Synchronous Motor - Equivalent Circuit 

The BEMF is equal to the result of the „Transformer Voltage”. 

Fig. 204: Synchronous Motor - BEMF equivalent 
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The calculation of the BEMF is not mandotary. All results of the „Nominal Torque + Inductance 

Calculation“ are available in “Results” after the calculation was performed. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 205: Synchronous Motor - Results of "Nominal Torque ... Calculation" 
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6.3.1 Synchronous Motor - Field Plots 
 

In “Plots” is the rotor current entered in column “i_r” manually or inserted by menu sequence „Data - 

Paste Currents to set No. # - source“. 

 

 

Fig. 206: Synchronous Motor - Rotor Coil Excitation in "Plots" 

The current densities are set in rotor and stator winding related to the winding scheme. 

 

 

Fig. 207: Synchronous Motor - Plots - Excitation Sources 

 

Fig. 208: Syncvhronous Motor - Plots - Flux Densities and Flux Lines 

 

  



 
  
 

  

 133 

smartFEM 

6.4 Switched Reluctance Motor 
 

The creation of a SR motor model simulation is initialized via "File - New - Select Motor Type". At least 

one SR rotor topology (* .top) must be stored in the topology directory in order to display the „SR - Motor“ 

menu item.  

 

  

Fig. 209: SR motor initialization 

The rotor topology of an SR motor differs from that of a PM motor in that only rotors without magnets 

can be selected. 

 

  

Fig. 210: SR motor - Example of a geometry model 

In „Motor Parameters“, the current can be specified as "User Defined Phase Current". 
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Fig. 211: SR motor - User Defined Phase Current 

Because the phase positions of the windings of a SR motor cannot be determined from motor topology 

and winding scheme, a torque calculation with a constant current is performed for each phase. The 

maxima of torques then correspond to the respective phase position. To perform this calculation, the 

"ReCaculate Phase Current" button must be clicked in “Motor Parameters”. Subsequently, at the next 

"Nom. Torque + Inductance" calculation, the phase positions are calculated before and displayed in 

"Motor Parameters". 

 

  

Fig. 212: SR motor - Determination of phase positions 

  



 
  
 

  

 135 

smartFEM 

The simulation results are then displayed in the same way as described in the previous chapters. 

 

 

 

Fig. 213: SR motor - Results 
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6.5 Synchronous Reluctance Motor 
 

The creation of a SR motor simulation model is initialized via "File - New - Select Motor Type". At least 

one SR rotor topology (* .top) must be stored in the topology directory in order to display the „SR - Motor“ 

menu item.   

 

  

Fig. 214: Synchronous Reluctance Motor -Initialization 

A motor model with 4 poles and 4 flow barriers (rotor topology CR_31_Synchronous_Relectance) with 

rotor position in d-axis is displayed.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 215: Synchronous 
Reluctance Motor - 4 poles 
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Example: Results „Torque vs. Theta“ from parametric Ld/Lq calculations inlc. phasor diagram of the 

maximum of torque. 

 

Fig. 216: Synchronous Reluctance Motor - Example of simulation results 

 

 

6.5.1 Synchronous Reluctance Motor PM-Assisted 
 

This type of motor is defined in smartFEM as „PM BLDC - Inner Rotor“. The name of the rotor topology 

is „CR31_Synchronous_Reluctance_PM_Assisted“. 

 

 
 

Fig. 217: Synchronous Reluctance PM-Assisted Motor - Rotor Topology 

 

Example: Results of “Torque vs. Theta” from parametric Ld/Lq caculations incl. phasor diagram of the 

maximum of the torque. 
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Fig. 218: Synchronous Reluctance Motor PM-Assisted - Example of Simulation Results 
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6.6 Universal motor 
 

The creation of a Universal Motor model simulation is initialized via "File - New - Select Motor Type". At 

least one universal rotor topology (* .top) must be stored in the topology directory, so that the menu item 

„PM - Universal Motor“ is displayed.  

 

  

Fig. 219: Universal motor initialization 

The modeling of a universal motor does not differ from the modeling of the other motor types apart from 

the rotor and stator separated windings and the setting in „Motor Parameters“. 

 

 

Fig. 220: 2-pole universal motor with 24 rotor slots 
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After "Preprocessing", the following calculation can be performed: 

 

- Creation of plots of induction with/without rotor (or armature) and stator currents for the design 

of the magnetic circuit 

 

 

Fig. 221: Universal motor - Plot of induction and field lines 

DC and AC motors can be simulated via the settings in "Coil Examination - Current Parameters". The 

simulation is performed in several steps: 

 

- Calculation of the commutation sequence ("Commutation Sequence") 

- Calculation of torque during commutation („Switching Torque“) Determination of the torque 

- Calculation of torque in AC or DC operation ( "Motor Torque") 

- Calculation of the rotor position for the positioning of the brushes 

 

 

Fig. 222: Universal motor - Motor parameters 
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6.6.1 Calculation of "Commutation Sequence" 
 

Since because of the missing magnets, "Cogging Torque + BEMF" cannot be determined, the "Nominal 

Calculation" is only possible without/with loss calculation. First, the basic parameters are set in "Motor 

Parameters" and the first simulation step "Commutation Sequence” is selected. The following 

calculations are performed after clicking "Apply" and "Calculation" buttons:  

 

- Excitation of the field winding with DC current (amplitude) at high armature speed. 

- Simulation without armature currents to determine the flux per winding depending on the 

winding scheme. 

- Simulation with rotation of the armature. 

- Determination of the induced voltage („Transformer Voltage“) in the armature windings and 

their phase positions. 

- Definition of the commutation sequence on the basis of the induced voltages. 

- Determination of a first brush position based on the induced voltage or flux in the windings 

- for a given armature position (windings with maximum flux or minimum induced voltage, 

respectively, begin to commute). 

 

After performing this simulation step, the phase positions of all windings are shown in "Motor 

Parameters". Coil no. 13 in slot 01 on the right and slot 13 on the left have the phase position 0 ° el. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Fig. 223: Universal motor - Position of the winding 13 

 

 

 

 

 

 

 

 

 Fig. 224: Phasing of the coils 
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In "Results“,the following 

graph, among other things, is 

dosplayed: 

 

"Transformer Voltage per 

phase": the graph for slot no. 

13 (phase position 0 ° el with 

the individual calculation 

points) is highlighted in 

green. 

 

 

 

Fig. 225: Universal motor - Transformer Voltage per rotor phase (Rotor Current = 0A) 

 

6.6.2 Calculation of torque during commutation "Switching Torque" 
 

The settings are made in "Motor Parameters - Calculation Steps". Among others can following graphs 

be displyed in "Results": 

 

For the chosen example with 2 stator slots and 24 rotor windings are the calculations 

performed across the rotor positions 0 - 15°mech. 

 

 

Fig. 226: Switching Torque - Stator currents 

 

Fig. 227: Switching torque - Rotor currents 
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Fig. 228: Switching 
Torque - Torque 

 

 

6.6.3 Calculation of torque in AC or DC operation "Motor Torque" 
 

For DC operation, constant current must be selected in "Motor Parameters - Coils Excitation". For the 

results shown below, sinusoidal current was set, i.e., the simulation was performed as of an AC motor. 

 

The unit of the abscissa is given in the time domain - in the example, the period of the sinusoidal stator 

current is 20 ms corresponding to a frequency of 50 Hz. 

 

 

 

 

 

 

 

Fig. 229: Motor torque - Stator 
currents 

 

The rotor currents from i_C 01 to i_C 13 have the same phase position. The rotor currents from i_C 14 

to i_C 24 also have the same phase position but an offset by 180 ° el compared to the previously 

mentioned one. 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 230: Motor Torque - Rotor 
currents 
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Fig. 231: Motor Torque - Torque of the AC motor 

 

 

6.6.4 Calculation of the rotor position for the positioning of the brushes 
 

For the calculation of the optimal position of the brushes, different brush positions, calculation angles 

and commutation lengths can be set via the menu sequence "Motor Parameters - Coil Excitation - 

Current Parameters". "Motor Torque" is selected in "Calculation Steps". The results are displayed as 

usual in the diagrams in the "Results" menu. 

 

 

Fig. 232: Universal motor - Positioning the brushes 
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6.7 PM - Linear motor 
 

The creation of a linear motor simulation model is initialized via "File - New - Select Motor Type". At least 

one linear motor topology (* .tol) must be stored in the topology directory so that the menu point „PM - 

Linear Motor“ can be displayed. 

 

   

Fig. 233: PM-Linear motor -Initialization 

 

6.7.1 Modellbildung 
 

The modeling of a linear motor differs from the modeling of the other motor types only that rotor geometry 

and stator geometry are parameterized in a "Geometry" topology. All other functions are the same - 

except for the calculation of the iron and magnetic losses and motor diagrams. 

 

 

Fig. 234: PM -Linear motor - Example of a geometry model 
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Fig. 235: PM-Linear motor - Representation of forces and flux density in the air gap 

 

6.7.2 Calculation of Losses 
 

Losses of linear motors are only calculated forperiodic models because for this only the Fourier 

transformations can be executed. 

 

Following topologies are periodic respective can be switched between periodic and non-periodic. 

 

• „H3LM2 Linear motor - periodic“  „H3LM3 Linear motor - full slot winding - periodic“ 

   

 Fig. 236: PM - Linear Motor - periodic models H3LM2 and H3LM3 

 

• „LM021c“ 
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The Paramter Type of Model“ was added to paraeter group „Geometry“. With this can the model be 

switched between non-periodec and periodic. When the periodic model selected then all non-periodic 

elements of the geometry are omitted. 

 

 

 

Fig. 237: PM - Linear Motor - LM021c, switching periodic / non-periodic 

• "LMxxx“ 

 

All other liniear motor topologies will be adapted accordingly. 

 

The loss calculation is carried out like rotational machines by selecting “Losses“ in “Motor 

Parameters“. After calculation “Nominal Force + Inductance“ is performed are the losses 

determined in “Postprocessing“. 

 

 

Fig. 238: PM - Linear Motor - Loss calculation 

6.8 Actuator 
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Geometry models of actuators such as valves can be designed with CAD software according to DXF 

import rules of smartFEM and be simulated after DXF import. 

 

   

Fig. 239: Actuator - CAD drawing  
Fig. 240: Actuator - smartFEM model after DXF import 

The CAD drawing must contain following basic parameter as text: 

• „Type of Motor = Actuator“ 

• „CompletePole = True/False“ oder “CompletePole“ bzw. „HalfPole“ 

 

Further parameter can be added optionally: 

• „CoordinateSystem = xy“ (defaultt value, if not specified)  

or „... = rz“ for rotation-symmetric models 

• Additional parameter accordingly other machine models such as: 

NPhases, Ns, NCoilsPerSlot, Bnd, Dp, etc. 

 

Actuators are actually treated as liniear motor will be later available as own machine type. The topology 

name for DXF import of actuator drawings is „LA_CADdata“. 

 

To determine the forces which are applied to the moving part (named as „platen“) the „ForcePath“ must 

be defined in the drawing as polygonal line and be marked by text „ForcePath“. In case that the forces 

should be calculated at different positions of the platen must the drawing also contain as line as vector 

which is marked by the text „MoveVector“. The movement of the platen is carried out from start point 

of the vector in direction of the end point. The maximum possible path correspondens to the length of 

the vector. 

 

To define the origin P(0,0) a point has to be drawn at an related position, which is located i.e. on the 

middle line with y=0 [P(0,0) = P(x,0)]. 
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Fig. 241: Actuator - ForcePath and MoveVector 

 

 

The polygonal line „ForcePath“ must deflect anti-clockwise 

arround the platen completely in air.  

 

 

 

 

 

The „MoveVector“ can be placed at any position. All elements of 

the geometry which are inside the area of the „ForcePath“ are 

displaced to a the related new position. 

 

 

 

 

 

The airgap is defined by the user and can be drawn as a line 

indicated by the text "Airgap" with between platen and stator. The 

length will be displayed after DXF import as parameter and will also 

be indicated in the graphic window. 

 

Fig. 242: Actuator - ForcePath and MoveVector 
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The geometry of the moveable part of the geometry must be 

surrounded by air and be connect by a line to the fixed part of 

the geometry.  

 

 

 

 

 

 

Fig. 243: Actuator - Connection of the moving part 
with the fixed part of the geome 

 

 

Fig. 244: Actuator - presentation of the "ForcePath" in smartFEM 

 

Fig. 245: Actuator - presentation of the "MoveVector" and displacement of the platen 
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Results after calculation of „Nominal Torque“ and „Plots“: 

- Force in dirction of the „MoveVector“ vs. „Displacement“ 

- Field plots 

 

 

Fig. 246: Actuator - Simulation and Results 

 

For rotation-symmetric actuators only the half of 

the geometry is allowed to be drawn beginning 

from the center line respectively symmetry axis 

to the right side. The origin P(0,0) should be 

drawn at the lower left corner. It is also 

mandatory to specify the basic parameter 

„CoordinateSystem = rz“. 

 

This functionality is still not implemented!  
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7 Interfaces 
 
7.1 Export of result data as tabled text 

 

All result data can be copied into other software tools by „Copy/Paste“ and partly also can be saved 

directly in tabled text files. 

 

Examples: 

 

  

Fig. 247: Export of result data as text - Cogging Torque 

 

 
 

 

Fig. 248: Export of result data as text - Model Data 
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7.2 Documentation “Project Report” 

 

smartFEM offers the possibility to create a project report by menu „File“→“Generate Project Report“, 

which is saved in a RTF-formetted textfile and can be edited by popular text programs. The contents of 

the report (design data, calculation results, and diagrams) can be selected by the user. 

 

The diagrams can be selected at the related simulation results: 

 

 

Fig. 249: Project Report - Selection of diagrams 

 

Diagrams in general and design parameter and calculation results as text can be selöected in a pop-

up windows after selction of the menu “Generate Project Report“: 

 

 

Fig. 250: Project Report - selection of design parameter and results as text 
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Example: 

 

 

Fig. 251: Projekt Report opened by Microsoft® Word  
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7.3 FEMAG 

 

smartFEM uses FEMAG for the numerical calculation of all the results, which are determined on the 

basis of the finite element method (FEM). For this, smartFEM transfers all necessary information to 

FEMAG and controls all FEMAG processes 

 

• to create the simulation model required for analyzing and evaluating the numerical 

computations - triggered by pressing the "Preprocessing" button. 

 

• to perform all analyzes and evaluations - triggered by pressing the "Calculation" button.  

 

smartFEM receives all relevant data from the FEMAG results files for further calculations, evaluations 

and graphical representations. 

 

Running FEMAG processes can be contolled and aborted at any time by pressing the "Calculation 

Running" button without losing any data. 

 

The user can start FEMAG at any time directly by pressing the "FEMAG" button. It will be used in the 

version that was previously set through "Tools → smartFEM Settings → User FEMAG Exe File". By 

clicking on the „FEMAG“ button with the right mouse button, a following selection menu is offered: 

 

 

Fig. 252: Starting FEMAG from smartFEM 

 

• "Empty FEMAG" 

FEMAG is started. The user can create a new FEMAG model or edit an already existing one. 

 

• "Copy Preprocessing Files With Name" PreFile "" 

The current smartFEM model is available as a copy in the specified FEMAG directory under the 

names "Prefile.a7" and "PreFile.i7". At the same time, FEMAG is started and the user can load 

and edit the model using the FEMAG command "Select Input File". Changes and evaluations to 

the model made by the user are not accepted by smartFEM. 
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7.4 CAD - DXF Import 
 

7.4.1 Topologies 
 

For the import of 2D rotor and stator geometries created with CAD systems, special topologies have 

been implemented which allow the import of geometry data in the DXF or CSV format: 

- „PM BLDC - Inner Rotor” 

o CR_CADdata.top 

o CS_CADdata.top  

 

- „PM – BLDC Outer Rotor”, „PM DC - Brushed Motor” 

o OCR_CADdata.top 

o OCS_CADdata.top  

 

- „Synchonous Motor” 

o Sync_CADdata.top 

 

- „SR Motor”  

o SR_CADdata.top 

 

- „Sync. Reluctance Motor” 

o SyncRel_CADdata.top 

 

- „Universal Motor” 

o UR_CADdata.top 

 

- „Linear Motor” 

o LM_CADdata.top 

“Actuator” 

o LA_CADdata.top 

 

First they have to be opened like the "usual" topologies, before an import file can be selected.  

 

 

7.4.2 DXF Import - Keywords and Parameter 
 

The basis for the implementation of the DXF interface is the documentation named 

"Autodesk_2011_dxf_reference_v.u.25.1.01" by Autodesk, Inc., USA. 

 

The entities "POINT“, “LINE“, “LWPOLYLINE“, “ARC“, “CIRCLE“, „TEXT“  und „MTEXT“ containing 

smartFEM relevant data are selected from the DXF files and all the information required for the 

simulation is generated: 

 

- POINT:  The origin P(0) of the smartFEM coordinate system has the coordinates x = 0 

and y = 0 and represents the center point of all rotor and stator geometries. 

 

  Note: 

  If the origin of the coordinates exported to a DFX file from a CAD system is not 

at the center of the rotor or stator geometry (= intersection point of the right 

and left sector line of the pole), an additional point in this point has to be 

created in the CAD. 

 

- ARC, 

 CIRCLE, 
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- LINE, 

 SPLINE:  Out of the the selected information, the start and end points are generated. 

For arcs and circles, the center points are generated and numbered form 1 

to n, taking a „PickPointRadius“ into account. 

 

- TEXT:  The following texts are required as additional information in smartFEM: 

 

   

Fig. 253: DXF-Import - Example of the import of a stator geometry 

 

Following keywords and parameter must be obgliatory or can be optionally defined in the CAD drawing: 

Obligatory Keywords and Parameter 
 

Keyword Parameter Description 

 

Type of Motor  

 

= PM - Inner rotor 

 

= PM - Outer rotor  

 

 

= SR - Motor- inner rotor 

 

= Sync. Reluctance Motor - 

Inner Rotor 

= Universal motor 

 

= PM - Linear motor 

 

= Actuator 

 

  

Motor type: PM Inner rotor  

 

 PM outer rotor  

 PM brush motor  

 

 Switched Reluctance motor  

 

 Synchronous Reluctance 

Motor  

 

 Universal motor  

 

 PM_Linear motor 

 

 Actuator 
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Position  

 

= Rotor 

 

= Stator 

 

Geometry type: Rotor 

 

 Stator  

 

Note: When linear motors are concerned, 

the geometries below the air gap are 

defined as "Rotor", and those above as 

"Stator" 

 

Optional Keywords and Parameter 
 

Keyword Parameter Description 

 

Not used keywords 

have the value = False  

 

HalfPole 

 

 

CompletePole  

 

 

 

 

 

MirrorPole  

 

 

 

 

SegmentedGeometry  

 

 

CompleteGeometry 

 

 

 

 

 

 

 

 

 

 

 

 

CoordinateSystem 

 

 

 

 

 

[…] = default value if no  

parameter is specified 

 

[= True] 

 

 

[= True] 

 

 

[= [True;] Asymmetric] 

 

 

[= True] 

 

 

= False 

  

[= True] 

 

 

[= True] 

 

 

 

 

 

 

 

 

[= True; Periodic]  

 

 

 

[= xy] 

 

[= rz] 

 

 

 

 

The geometry describes a half pole and is 

mirrored in the FEM model. 

 

The geometry describes an entire pole. It is 

not mirrored in the FEM model. 

 

The geometry describes a whole 

geometrically unsymmetrical pole.  

 

The pole geometry is mirrored in the FEM 

model. 

 

The pole geometry is not mirrored.   

 

A segemnted geometry with n poles per 

segment. 

 

The complete geometry with all stator and 

rotor poles (360 °mech). It can be non- 

symmetrical with respect to the individual 

poles and thus non-periodic with respect 

to the BEMF. It is adopted without changes 

to the FEM model. The FEM calculations 

are performed with 360 °mech rotation of 

the rotor. 

 

The complete geometry is periodic with 

respect to the BEMF. The FEM calculations 

run over the BEMF period [° mech]. 

 

The geometry is designed in xy section 

 

The geometry is rotaion-symmetric 
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The following texts is required to assign type of material to areas. The anchoring points of the text boxes 

must lie in the corresponding area elements. Many parameters have to be separated by the character 

semicolon ";". No specific order of parameters is prescribed. 

 

The areas defined in this way can be selected in the geometry window of the topology with the mouse 

and be edited. Areas without an assigment of a material type are treated as air. 

 

Keyword Parameter Description 

 

Magnet 

 

 

 

[; MaterialNo = #] 

or [; MatNo = #] 

 

[; Length = #.##] 

 

 

[; MagAngle = #.##] 

 

 

 

Material = Magnet 

 

Material number according to the material 

data defined in "Materials" for the model. 

 

Relative magnetic length in the axial z- 

direction [% of the motor length “Lmot”] 

 

Angle of the magnetization direction with 

respect to the x-axis [°mech] 

 

Steel 

 

 

 

[; MaterialNo = #] 

or [; MatNo = #] 

 

[; Length = #.##] 

 

 

 

Material = electrical sheet 

 

Material number according to the material 

data defined in "Materials" for the model. 

 

Relative length in the axial z- direction [% of 

the motor length Lmot] 

 

Coil 

 

 

 

[; MaterialNo = #] 

or  

[; MatNo = #] 

 

 

[; SlotSideIndex = #] 

 

Material = coil 

 

Material number according to the material 

data defined in "Materials" for the model. 

 

 

 

Indicates on which side of the slot the coil is 

lying.  

 

[Air] 

  

Material = air  

 

 

 

Optional parameters 

 

The following texts may be included. If no information is contained, smartFEM automatically calculates 

these values from the selected geometry points. 

 

Note: 

External radii must correspond to the maximum or minimum distance between the center point and the 

outer or inner contour of the respective geometry. If the contours are not circular-shaped, it is possible 

that the radii on the sector lines of the pole segments cannot be determined from the geometry points. 

In this case, they must be specified. 
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Keyword Parameter Description 

 

Rro = 

 

 

#.### 

 

Outer radius rotor 

 

Rri = 

 

 

#.### 

 

Internal radius rotor 

 

Rso = 

 

 

#.### 

 

Outer radius Stator 

 

Rsi = 

 

#.### 

 

Internal radius Stator 

 

 

Np = 

 

 

alternative Ns = 

i.e. Nm = 

 

## 

 

 

## 

## 

 

Number of poles for rotor or stator 

according to "Position" 

 

Number of stator slots 

Number of magnet poles 

 

 

 

Node distances or number of segments can be specified as follows for lines and arcs. The text boxes 

must be positioned in such a way that the anchoring points lie as close as possible to the respective 

lines or arcs. 

 

 

NDistFact = 

or NDist = 

 

 

#.####  (default: 1.0) 

 

Factor for setting the knot density = Bna * 

NDistFact = Bna * NDist 

 

NDistFactNlin = 

or NlinDist = 

 

#.####  (default: 0.0) 

 

Factor for determining a nonlinear node 

density on the lines. 

 

In case of a positive factor and positioning 

of the text box closer to the end point of the 

line, the node density is distributed from low 

to high in the direction from start to end 

point, in the case of a negative factor or 

positioning closer to the starting point in the 

opposite direction. 

 

 
 

  



 
  
 

  

 161 

smartFEM 

 

NSeg = 

 

### 

 

Number of segments, into which line and 

circular arcs are divided by the nodes. 

 

 

Further optional parameters 

 

Keyword Parameter Description 

 

MiddleSlotLine 

  

Marking the line, which divides the slot in 

the right and left side in unbalanced 

geometries. 

 

 

NCoils =  

NCoilsPerSlot = 

 

CoilsLayer = 

 

 

 

 

 

1 or 2, default = 2 

 

 

UpDown 

 

 

RingCoils 

 

One or two-layered coil 

Coil in the left/right slot half 

 

Coil in upper/lower slot half (only for two-

layered coil) 

 

Ring coil around the stator back 

 

 

NSlotsPerSegment 

 

 

## 

 

Number of slots per segment in segmented 

geometries („SegmentedGeometry”) 

 

 

NPhases = 

 

##, default = 3 

 

 

Number of phases 

 

Bna =  

 

 

Bnd = 

 

 

#.###, default: = 1.0 

 

 

#.###, default: = 0.3 

 

BasicNodeAngle = minimum angle 

between two nodes at the air gap. 

 

BasicNodeDistance = minimum distance 

between two nodes at the air gap. 

 

 

Dp = 

 

#, default = 2 

 

 

Number of decimal places for the rounding 

of the entered and displayed parameter 

values 

 

 

With the help of the CAD program "Solid Edge 2D-Drafting" from Siemens PLM Software, text can also 

be assigned to the respective lines, arcs, etc. by means of a text bubble. 
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7.4.3 Examples of CAD drawings 
 

7.4.3.1 Example of a Stator Geometry 
 

 

 
Fig. 254: CAD import - Example stator geometry 

 

smartFEM detects the position in the xy-level and rotates the topology so that it is displayed as the 

"usual" standard topologies. 
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7.4.3.2 Example of rotor geometry with node densities 
 

 

 
Fig. 255: CAD Import - Example of a rotor geometry 

The arrangement of node densities information can be done with the help of text boxes and text bubbles. 

Currently, only text bubbles in Solid Edge 2D drafting by Siemens PLM software are available and can 

contain different start/end symbols (e.g. arrow, circle, etc. without bending lines). 

 

7.4.3.3 Example of rotor geometry with “SPLINE” 
 

"Splines" can be designed in the CAD drawing with n control points and degree < n. 

 

    

Fig. 256: CAD drawing with SPLINE  

smartFEM material view after DXF import of the 

winding area showing also the control points of 

the spline which is displayed as curve “C1” 
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7.4.3.4 Example of a complete stator geometry 
 

 
 

Fig. 257: DXF import - Complete geometry 

 

7.4.3.5 Example of a complete stator geometry with offset 
 

If a line is drawn at the zero point of stator geometry, an eccentricity between rotor and stator is 

generated in smartFEM according to the length and direction of the line.  

 

 

Fig. 258: DXF Import - Eccentricity between rotor and stator 
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7.4.4 Use of Layers in the CAD Models 
 

If the CAD model should contain more information than the dfx import basics (e.g., guidelines, 

dimensions, etc.), layers must be used. The drawing objects and text required for the DXF import to 

smartFEM must be contained in layers that on their part contain the word "smartFEM". Several 

"smartFEM" layers can be defined. All other information must be drawn in other layers. If no layers are 

used, the CAD model is allowed to contain only the information required for the smartFEM DXF import. 

 

 

Fig. 259: CAD Import - Using Layers 
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7.4.5 Keywords and Parameter of Linear Motors 
 

Topologies of linear motors contains always out of the rotor and stator geometry. By definition must the 

rotor geometry be below the stator and airgap geometries. For identification of geometry and motor 

parameter must different information be defined as “Basic Parameter” in the DXF drawing. The anchor 

points of the text boxes must be positioned very close to the related points. 

Obligatory Keywords and Parameter 

Keyword Parameter Description 

 

Np 

 

 

NpComplete 

 

AirGapTickness 

 

 

MotorStartsXCoord 

 

 

 

SlotStartsXCorrd 

 

 

 

SlotPitchLength 

 

 

MotorLength 

 

= # 

 

 

= # 

 

= P1 : P2 

 

 

= P3 

 

 

 

= P4 

 

 

 

= P3 : P4 

 

 

= P5 : P7 

 

Number of poles within the active motor length. 

 

Total number of poles. 

 

Geometry points which indicates the thickness of the 

airgap . 

 

Geometry point which indicates the x-coordinate of the first 

left point of the motor geometry. 

 

Geometry point which indicates the x-coordinate of the first 

left point of the first left stator pole. 

 

Geometry points which indicate the length of a stator pole 

 

Geometry points which indicate the active length of the motor. 
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Example: 

 

 

Fig. 260: DXF-Import Linear Motor - Basic Parameter 

 

 

Fig. 261: DXF-Import Linear Motor - Basic Parameter "AirGapThickness" 
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7.4.5.1 Keywords and Parameter of Actuators 

 

 

Keyword Parameter Description 

 

Type of Motor 

 

CoordinateSystem 

 

NPhases 

 

Ns 

 

NCoilsPerSlot 

 

CompletePole 

or 

HalfPole 

 

 

ForcePath 

 

 

MoveVector 

 

 

= Actuator 

 

= [xy | rz]  (xy=default) 

 

= # 

 

= # 

 

= # 

 

[= False | True] 

 

 

Type of model 

 

Coordinatesystem xy or rotationsymmetric 

 

Number of phases 

 

Number of slots 

 

Number of coils per slot 

 

complete 

or 

half geometry (madatory for 

COOrdinateSystem = rz) 

 

Polyline indicating the path to calculate the 

forces applied to the platen. 

 

Line indicating the direction and length of 

the movement.of the platen. 

 

Fig. 262: DX-Import Actuator - Basic Parametrer 

Example: 

(see also § 6.7 Actuator) 

 

 

 

 

 

 
Fig. 263: DXF-Import Actuator - 

ForcePath and MoveVector 
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Fig. 264: DXF-Iport Actuator - ForcePath and MoveVector in smartFEM (Geometry Plot) 

 

 

Fig. 265: DXF-Import Actuator - ForcePath and MoveVector in smartFEM (Material Plot) 
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After DXF import is the geometry of the actuator displayed as in the CAD drawing. 

 

 

     

Fig. 266: DXF Import Actuator - Direction of the "MoveVector" ≠ 0 

After "Apply" is the geometry automatically rotated in such a way that the "MoveVector" is in 0°mech (x-

axis) direction. With that can the ration of x- and y-forces properly be calculated (x-direction = moving 

direction). 

 

     

Fig. 267: DXF Import Actuator - Rotated geometry with "MoveVector" in direction of the x-axis  

     

Fig. 268: DXF Import Actuator - Forces in x- and y-direction when geometry is asymmetrical     
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7.4.6 Functional description of the DXF import 
 

After selecting the CAD_Rotor or CAD_Stator topology, an empty geometry and parameter window is 

displayed as well as a selection window for selecting a DXF or CSV file. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 269: DXF-Import - Selection of the DXF or CSV file 

After selecting the corresponding file, the import is performed toherther with the construction of geomerty 

and the display of the parameter list: 

 

 

Fig. 270: DXF-Import - Example of imported stator geometry 
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The information about individual lines, arcs, etc. can be specified by entering their index number. In 

addition to the numeric information in the parameter list, context-sensitive auxiliary information is 

displayed in the graphics window. 

 

 

Fig. 271: DXF-Import - Information on geometry elements 

 

Entering the line, arc, area and point numbers displays additional information. The node distances can 

be changed for each element. 

 

Example: 

-  Bow: A5 

- Center point: 16 

- Starting point: 18 

- Endpoint: 17 

- Factor for minimum Node distance:  0.5        (Node distance = factor * basic node distance) 

- Radius: 1 mm 

- Opening angle: 97.73 ° 

 

In the "Geometry" and 

"Nodes" view of the 

graphics window, individual 

elements can also be 

selected with a right mouse 

click on the corresponding 

element.  

 

 

 

 

 

 

 

 

 

Fig. 272: DXF-Import - Selection of a geometry element 
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7.4.7 Pre-Requirements and Error Notes 
 

When creating DXF or CSV files, the following points have to be considered, so that smartFEM can build 

up a simulation-capable geometry model. 

 

7.4.7.1 Free Area Elements 
 

The geometries must not contain any surface elements (islands) that are not connected to another area 

element by a line or circular arc. 

 

If this is still the case, the corresponding surface element is displayed with a red border in the geometry 

representation, an error message is displayed and the "Bad Geometry" button is displayed instead of 

"Apply". A connection must then be established in the CAD system and the import performed again.  

 

 

Fig. 273: DXF-Import - Free surface elements 

 

7.4.7.2 Unique Points 
 

Rounding differences in the 

creation of the DXF or CSV 

files for the import can lead to 

the possible situations that 

the same points have slight 

different xy-coordinates and 

are recognized as two points. 

To prevent this, the minimum 

distance between two points 

„MinDist“ can be specified as 

a parameter in the parameter 

group "Basic". xy-

coordinates which have a 

smaller distance to each 

other are then recognized as 

one point. 

 

 

Fig. 274: DXF Import - Minimum Distance of Points 
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7.5 DXF Export 
 

The geometries created with smartFEM can be exported in dxf format in two different ways, in order to 

be used with other programs: 

 

- Export from the respective topology window 

A complete geometry model including all related information as text for e.g. CAD systems for 

changes to geometry and/or text parameters with subsequent re-import into smartFEM 

 

- Export via the smartFEM main menu 

Various types of geometry model for e.g. CNC machines for sheet metal cutting 

 

 

7.5.1 Export from the respective topology window 
 

This function is called up via the menu "File - Export Topology to DXF" specified in the topology window. 

 

 
 

Fig. 275: DXF Export - export topology to DXF 

The user can specify in which directory the DXF file should be stored. Different layers with the term 

"smartFEM ..." are created for the respective information types. Text size of the of node distances are 

adjusted to the respective lengths of the lines and arcs. 

 

After being opened in a CAD system, geometry and text parameters can be modified and, after saving 

as a DXF file, imported back into smartFEM with the corresponding CADdata topology (in this example 

CR_CADdata). 
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Fig. 276: DXF Export - representation in a CAD system 

 

The 2D-Model of the CAD system can contain any drawing and text information. The information 

required for the import into smartFEM and only these must respectively can be contained in layers that 

contain the text "smartFEM". 

 

 

Fig. 277: DXF Export - smartFEM layer in 2D model of the CAD system 

 

 

  



 
  
 

  

 176 

smartFEM 

7.3.2 Export via the smartFEM main menu 

 

With this function, only geometric data is exported to a DXF file in the smartFEM geometry file 

according to the respective view: 

 

- Rotor 

- Stator 

- Periodic model 

- FEM model 

 

additionaily, e.g. for the programming of CNC machines 

- Export Material Contours 

- Export Steel Material Contours 

 

 

Fig. 278: DXF Export - Example stator geometry 

 

 

Fig. 279: CAD Export - Selection of different types 
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Fig. 280: DXF Export - Example: Contour of the stator laminated core 

To export the entire model, the winding editor must be opened by clicking on the "Winding Defined" 

button. The entire model is then displayed and can be exported with "File - DXF Export - Periodic Model". 

Uneccessary drawing lines need to be removed in CAD system, so that only e.g. the contours can be 

further processed. 

                               

Fig. 281: DXF Export - Entire machine model    

Fig. 282: DXF Export - Material contours 
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7.6 CASPOC 
 

For simulation of motor control with the simulation tool for power electronics CASPOC1, the parameters 

required for Ld/Lq calculation can be generated directly via the "Data- Caspoc - Add Sets" dialog and 

then calculated using "Solve All".  

 

 

Fig. 283: CASPOC calculation parameters 

Subsequently, the generated result table with further results data can be stored in a XML formated file 

which can be processed directly by CASPOC. 

 

 

Fig. 284: CASPOC - Saving of the results data to an export file 

The file contains the following data: 

 

Motor parameters 

- stator inductance Ld 

- stator inductance Lq 

- Winding resistance 

- moment of inertia of the rotor 

- number of pole pairs 

 

Data table1 

- Rotor position [° mech] 

- Phase shift current [° el] (not used = 0) 

- Amplitude of current (not used = 0) 

- Torque (= locking torque) 

- ke1 Voltage constant phase U 

- ke2 Voltage constant phase V 

- ke3 voltage constant phase W 

- flux linkage 1 

- flux linkage 2 

- flux linkage 3 

 

 
1 CASPOC is a product of Simulation Research, NL - Alphen aan den Rijn 
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Data table2 

- Rotor position [° mech] (=0) 

- Phase shift current [° el]  

- Amplitude of the current 

- Torque 

- ke1 voltage constant phase U (not used = 0) 

- ke2 voltage constant phase V (not used = 0) 

- ke3 voltage constant phase W (not used = 0) 

- Ld 

- Lq 

- flux linkage 3 (not used = 0) 

 

 

 

Fig. 285: CASPOC - example XML file 
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8 Notes 
 

 

 


